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1. Bienvenue dans l'aide de COPA-DATA 

TUTORIELS VIDÉO DE ZENON. 

Des exemples concrets de configurations de projets dans zenon sont disponibles sur notre chaîne 
YouTube (https://www.copadata.com/tutorial_menu). Les tutoriels sont regroupés par sujet et 
proposent un aperçu de l’utilisation des différents modules de zenon. Les tutoriels sont disponibles en 
anglais.  
 

AIDE GÉNÉRALE 

Si vous ne trouvez pas certaines informations dans ce chapitre de l’aide, ou si vous souhaitez nous 
suggérer d’intégrer un complément d’information, veuillez nous contacter par e-mail : 
documentation@copadata.com (mailto:documentation@copadata.com). 

 

ASSISTANCE PROJET 

Si vous vous rendez compte que vous avez besoin de licences ou de modules supplémentaires, 
veuillezcontacter l’équipe commerciale par e-mail : support@copadata.com 
(mailto:support@copadata.com) 

 

LICENCES ET MODULES 

Si vous vous rendez compte que vous avez besoin de licences ou de modules supplémentaires, 
veuillezcontacter l’équipe commerciale par e-mail : E-mail sales@copadata.com 
(mailto:sales@copadata.com). 
 

2. Interfaces de programmation 

Différentes interfaces d'intégration de vos programmes ou d'automatisation des plannings sont 
disponibles dans zenon : 

https://www.copadata.com/tutorial_menu
mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com
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 Liste des macros (à la page 38) (VBA)  

 VSTA (à la page 86)  

 Add-In Framework (à la page 26) (Add-Ins) 

 Process Control Engine (PCE) 
À partir de la version 7.20, le module PCE n'est plus pris en charge et ne sera plus affiché dans 
l'arborescence des modules de zenon. Lors de la conversion de projets contenant des tâches PCE 
depuis des versions antérieures à la version 7.20, le nœud PCE sera affiché pour ces projets. PCE 
ne fera plus l'objet de développements ou de documentations ultérieures. 

  Veuillez utiliser zenon Logic, plutôt que PCE 

  Informations concernant la licence 

Composante de la licence standard d’Editor et du Runtime. 

MENU CONTEXTUEL 

Élément de menu Action 

Ouvrir l'éditeur VBA Ouvre l'éditeur VBA. 

Ouvre l'éditeur VSTA avec  
Projectaddin  

Ouvre l'éditeur VSTA. 

Aide Ouvre l'aide en ligne. 

 

  Informations 

Vous trouverez des informations concernant la création et la mise en  œuvre des 
contrôles (ActiveX, .NET, WPF) dans le manuel Contrôles. 
Vous trouverez des informations concernant le développement et l'utilisation de 
l'interface SAP au chapitre Interface SAP. 

OUVRIR EDITORS 

L’ÉDITEUR VBA, LISTE DES MACROS 

VBA démarre le même environnement de développement pour Espace de travail et le projet.  
Pour ouvrir l'Éditeur VBA : 

1. Dans zenon Editor, accédez au nœud Interfaces de programmation. 

2. Expand the view of this node by clicking on [+]. 
The view of the node is expanded. 
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3. Right-click on Macro list 

4. Sélectionnez Open VBA Editor... (Ouvrir l'Éditeur VSTA) dans le menu contextuel. 

 : appuyez sur les touches . 

VSTA DANS L’ÉDITEUR 

VSTA comporte des environnements de développement distincts pour l'Espace de travail et le projet. 
Vous ne pouvez en utiliser qu'un à la fois. Au démarrage, tous les autres environnements de 
développement VSTA ouverts seront fermés. 

Pour ouvrir l'Éditeur VSTA pour l'espace de travail : 

1. Appuyez sur les touches Alt+F10. 

Le code correspondant à l'espace de travail et à tous les projets chargés est affiché 

Pour ouvrir l'Éditeur VSTA pour le projet actuellement chargé : 

1. Accédez au nœud Script. 

2. Expand the view of this node by clicking on [+]. 
The view of the node is expanded. 

3. Cliquez avec le bouton droit sur VSTA 

In the context menu, select Open VSTA editor with ProjectAddin. 
The editor is opened for the currently-loaded project. 

API À PARTIR DE LA VERSION 7.10 : 

Pour utiliser les interfaces de programmation de  zenon, les considérations suivantes sont applicables à 
parztir de zenon 7.10 : 

 VSTA/.NET: .NET Framework 3.5 doit être disponible. 

 VBA : Si, dans le code VBA, des fonctions de l'API Windows ou d'autres fichiers DLL importés sont 
utilisées, ces exécutions doivent être adaptées à l'environnement 64 bits. En règle générale, les 
dispositions suivantes s’appliquent : Un fichier VBA créé avec une version 32 bits ne peut pas 
être utilisé sans modification dans une version 64 bits de VBA. 

Attention 

Les erreurs dans les applications telles que ActiveX, PCE, VBA, VSTA, WPF et les 
applications externes accédant à zenon via l'API peuvent également influencer la 
stabilité du Runtime.  
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3. Add-Ins 

Add-Ins provide possibilities to expand the functionality of zenon in the Editor and in Runtime with 
different development environments.  
The following are available to you to create Add-Ins: 

 Microsoft Visual Studio (à la page 22) 

 SharpDevelop (included in the installation package) (à la page 20) 

Add-Ins can be created with each .NET programming language. IDE support is available for the 
programming languages C# and Visual Basic.NET. 

Note: 

 All lists and interfaces support IEnumerable. 
Reference: https://msdn.microsoft.com/de-de/library/9eekhta0(v=vs.110).aspx 
(https://msdn.microsoft.com/de-de/library/9eekhta0(v=vs.110).aspx ) 

 LINQ (Language Integrated Query) can be used.  
Reference: https://msdn.microsoft.com/en-us/library/mt693024.aspx 
(https://msdn.microsoft.com/en-us/library/mt693024.aspx) 

Attention 

For Add-Ins, the .NET Naming Guidelines are used. 

The object names previously used for VSTA and VBA are amended for this. In VSTA and 
VBA, the previous names remain the same for compatibility reasons. For Add-Ins, naming 
according to the .NET Naming Guidelines has been used. 

You can find an overview of the respective object names in the 
API_Naming_Conversion.xlsx Excel table. You can find this in the zenon installation 
path in the \HELP\AddIns folder. 

FUNCTIONALITY 

Add-Ins allow you to do the following, among other things: 

 Provide project configuration aids (such as wizards) 

 To enhance the project in Runtime with additional functionality 

You can find Add-Ins: 

 For the Editor in the Extras menu under the following entries: 

 Manage Editor Add-Ins 

 Start Editor Wizards 

 Manage Editor services... 

https://msdn.microsoft.com/de-de/library/9eekhta0(v=vs.110).aspx
https://msdn.microsoft.com/en-us/library/mt693024.aspx
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 For Runtime in the Programming interfaces - Add-Ins node 

TOOLS AND SUPPORT 

You can get tools and support at: 

 Visual Studio developer tools: marketplace.visualstudio.com 
(https://marketplace.visualstudio.com) 

 COPA-DATA user forum: forum.copadata.com (https://forum.copadata.com/) 
 

3.1 Prior knowledge 

As with the creation of other software components, certain prior knowledge is also necessary for the 
development of Add-Ins for zenon. 

This includes 

 Programming knowledge in C# or VB.NET (depending on the requirement / complexity of the 
Add-Ins to be developed) 

 Good zenon knowledge 

The following is also recommended 

 Experience in using professional development environments (such as Microsoft Visual Studio) 

 The use of a version management system for the developments (TFS, SVN, GIT) 
 

3.2 Terminology 

Specialist terms and their meaning in relation to Add-Ins. 

https://marketplace.visualstudio.com/
https://forum.copadata.com/
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Term Meaning 

Add-In A collection of Extensions. Is represented by the add-in package. 
An Add-In can contain several Extensions. 

Add-In Assembly The compiled library (*.dll), that contains Extensions. 

Add-In Package A ZIP file (*.scadaAddIn), that contains metadata and libraries 
with their dependencies. 

An Add-In Package contains an Add-In Assembly. 

Extension 
Extensions are classes that can be derived from an interface 
with one or more methods. They are entry points in the Add-In 

Package. 

Each class that represents an Extension is marked with a .NET 
attribute. 

There are two types of Extensions (à la page 17), one for the 
Editor and one for Runtime 

 Wizard Extensions (Wizards) 

 Service Extensions (Services) 

IDE Integrated development environment. Abbreviation for Integrated 
Development Environment. 

Project Add-In Management Components for zenon Editor and Runtime that manage the Project 

Add-In Packages. 

Service Extension Implementation of an Extension that represents a Service. 

Services: 

 Runs in the background 

 Is started automatically or manually 

 Remains in the memory until it is stopped 

Wizard Extension Implementation of an Extension that represents a wizard. 

Wizards: 

 Are for solving a certain task 

 Are removed again after closing 

 Specialist terms are only used in English in the documentation for Add-Ins. 
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3.3 Limitations 

The following limitations are applicable for Add-Ins: 

 The zenon Web Client supports the execution of Add-Ins, however without IDE support. 

The local debugging of Add-Ins is not possible in the zenon Web Client for this reason; debugging 
using remote debugging tools is supported. 

 The execution of Add-Ins is not supported in the HTML web engine. 
 

3.4 Create add-in 

GENERAL INFORMATION 

Add-Ins are identified by means of the Add-In ID. It is used for installation and import. 

An Add-In ID consists of an optional Namespace and a local ID, namespace.localId. The Local ID 
identifies an Add-In; the Namespace assigns an Add-In to an organization. Both pieces of information 
areestablished by the NET attribute Mono.AddIn.AddInAttribute. In order for the name for an Add-In 
Package to also remain unique beyond organization boundaries, the Namespace of the Add-In project is 
used as part of the ID.  
Example of a complete Add-In ID: com.organisation.importwizard. 

The issue of Namespaces is optional.  
 Use Namespaces. This is how you ensure the global uniqueness beyond 

organizational boundaries. It is best to use the URL of your own organization in reverse order.  
For example: For www.example.com use com.example as a Namespace. 
Namespaces can be further divided within an organization, for example by teams, departments or 
projects. 

The following are available to you to create Add-Ins: 

 Microsoft Visual Studio (à la page 22) 

 SharpDevelop (included in the installation package) (à la page 20) 

Add-Ins can be created with each .NET programming language. IDE support is available for the 
programming languages C# and Visual Basic.NET. 
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3.4.1 Basics 

There are different Extensions available for the zenon Editor and zenon Runtime. Depending on the 
application, a corresponding Extension can be selected. 

 

All interfaces required for the development of Add-Ins are defined in the Scada.AddIn.Contracts 
assembly. 

An Add-In Package can contain one or more Extensions . 

TYPES OF EXTENSIONS - INTERFACES 

A distinction is made between the following Extensions : 

EDITOR WIZARD EXTENSION - IEDITORWIZARDEXTENSION (À LA PAGE 17) 

 Execution is triggered by the user using the Extras -> Editor Wizards... dialog in the zenon 
Editor. 

 Implements the Run method in order to execute a Wizard Extension in the zenon Editor. 

EDITOR SERVICE EXTENSION - IEDITORSERVICEEXTENSION (À LA PAGE 17) 

 Execution is carried out automatically when the Editor is started, depending on the 
DefaultStartMode. 

 For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must 
be set in the Extension. The start mode can also be changed with the Manage Editor services (à 
la page 33) dialog. 

 Administration is via the Extras -> Manage Editor services... dialog in the zenon Editor. 

 Implements the Start and Stop methods to execute a Service Extension in the zenon Editor. 
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PROJECT WIZARD EXTENSION - IPROJECTWIZARDEXTENSION (À LA PAGE 18) 

 Execution is triggered by the user with the zenon Exécuter l'extension du wizard project function. 

 Implements the Run method in order to execute a Wizard Extension in zenon Runtime. 

PROJECT SERVICE EXTENSION - IPROJECTSERVICEEXTENSION (À LA PAGE 18) 

 Execution takes place automatically when starting the project in Runtime, depending on the 
DefaultStartMode. 

 For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must 
be set in the Extension. The start mode can also be changed with the Manage Editor services (à 
la page 33) dialog. 

 Administration is carried out using the zenon Show "Manage Runtime services"  function. 

 Implements the methods Start and Stop to execute a Service Extension in zenon Runtime. 

EXTENSION ATTRIBUTES 

The following metadata is defined using the .NET attribute with the name AddInExtension. 
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Property Description IEditorWi

zardExte

nsion 

IEditorSe

rviceExt

ension 

IProjectW

izardExte

nsion 

IProjectS

erviceEx

tension 

Name Display name in dialogs. 

Corresponds to the name 
of the wizard or the service in 
zenon. 

X X X X 

Description Description of the display in 
dialogs. 

Corresponds to the 
description of the wizard or the 
service in zenon. 

X X X X 

Category Category for grouping in dialogs. 

 Is used to categorize 
wizards in the Editor Wizards... 
dialog in the zenon Editor. 

X -- X -- 

DefaultStartMode Describes the standard starting 
behavior of service add-in 
extensions after installation. 

 Manual: Extension must be 
started manually by the 
user. 

 Auto: Is started if the 
workspace in the Editor or 
the project is loaded in 
Runtime. 

N/A: Manual is used. 

Corresponds to the start 
type of the service in zenon. 

-- X -- X 

Key: 

 X: applicable 

 --: not applicable 

ADD-IN ATTRIBUTES 

An Add-In Assembly needs several .NET attributes, which are defined in the AddInInfo.cs file. 

The most important attributes and those necessary for use in zenon are: 
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Attribute name Obligatory Description Examples 

Addin X ID and version of the 
Add-In. 

 The version 
corresponds to the Version 
column in the Add-In 
administration dialog in the 
zenon Editor. 

Example 1: 

[assembly: 
Addin("AddInIdentifier", 
"1.0", 
Namespace="com.example
")]   

Example 2: 
[assembly: 
Addin("MultitouchAddIn", 
"1.0")]  

Example 3: 
[assembly: 
Addin("ProjectCreation", 
"1.0")] 

AddinDependency X Defines a dependency on 
the zenon system.  
This value is constant and is 
needed in order for zenon 
to use the Add-In 

[assembly: 
AddinDependency("scada", 
"1.0")] 

AddinName -- Name of the Add-In. 

 Corresponds to the 
Name column in the Add-In 
administration dialog in the 
zenon Editor. 

[assembly: 
AddinName("Editor Add-In 
Demo")] 

AddinDescription -- Description of the Add-In. 

 Corresponds to the 
Description column in the 
Add-In administration 
dialog in the zenon Editor. 

[assembly: 
AddinDescription("Demons
trates an Add-In with a 
Wizard and a Service 
extension.")] 

Key: 

 X: applicable 

 --: not applicable 
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3.4.2 Types of extensions 

Wizard in the Editor - Editor wizard extension 

Editor Wizard Extensions are used to implement wizards or other user-controlled API processes in the 
Editor. 

 Execution is triggered by the user using the Extras -> Editor Wizards... dialog in the zenon 
Editor. 

 Implements the Run method in order to execute a Wizard Extension in the zenon Editor. 

EXAMPLE CODE (C#) 

[AddInExtension("Wizard Extension Name", "Description of Wizard Extension", "Category of 

Wizard Extension")] 

public class WizardExtension : IEditorWizardExtension 

{ 

 public void Run(IEditorApplication context, IBehavior behavior) 

 { 

 // Implement feature here... 

 } 

} 
 

Services in the Editor - Editor Service Extension 

Editor Service Extensions are used to implement API processes in the Editor automatically. 

 Execution is carried out automatically when the Editor is started, depending on the 
DefaultStartMode. 

 For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must 
be set in the Extension. The start mode can also be changed with the Manage Editor services (à 
la page 33) dialog. 

 Administration is via the Extras -> Manage Editor services... dialog in the zenon Editor. 

 Implements the Start and Stop methods to execute a Service Extension in the zenon Editor. 

EXAMPLE CODE (C#) 

[AddInExtension("Service Extension Name", "Description of Service Extension", "Category 

of Service Extension", DefaultStartMode=DefaultStartupModes.Auto)] 

public class ServiceExtension : IEditorServiceExtension 
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{ 

 public void Start(IEditorApplication context, IBehavior behavior) 

 { 

 // Startup code here 

 } 

 public void Stop() 

 { 

 // Stop code here 

 } 

} 
 

Wizard in Runtime - project wizard extension 

Project Wizard Extensions are used to implement wizards or other user-controlled API processes in 
Runtime. 

 Execution is triggered by the user with the zenon Exécuter l'extension du wizard project function. 

 Implements the Run method in order to execute a Wizard Extension in zenon Runtime. 

EXAMPLE CODE (C#) 

[AddInExtension("Wizard Extension Name", "Description of Wizard Extension", "Category of 

Wizard Extension")] 

public class WizardExtension : IProjectWizardExtension 

{ 

 public void Run(IProject context, IBehavior behavior) 

 { 

 // Implement feature here... 

 } 

} 
 

Service in Runtime - project service extension 

Runtime Service Extensions are used to implement background tasks in Runtime. 

 Execution takes place automatically when starting the project in Runtime, depending on the 
DefaultStartMode. 
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 For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must 
be set in the Extension. The start mode can also be changed with the Manage Editor services (à 
la page 33) dialog. 

 Administration is carried out using the zenon Show "Manage Runtime services"  function. 

 Implements the methods Start and Stop to execute a Service Extension in zenon Runtime. 

EXAMPLE CODE (C#) 

[AddInExtension("Service Extension Name", "Description of Service Extension", "Category 

of Service Extension", DefaultStartMode=DefaultStartupModes.Auto)] 

public class ServiceExtension : IProjectServiceExtension 

{ 

 public void Start(IProject context, IBehavior behavior) 

 { 

 // Startup code here 

 } 

 public void Stop() 

 { 

 // Stop code here 

 } 

} 
 

3.4.3 Content of add-in packages 

Add-In Packages are ZIP files with the filename extension .scadaAddIn. They contain binary data and 
metadata. Binary files must be present and can be saved as their own ZIP file in the Add-In Package. 
Packages can be created with the Add-In Utility (à la page 24). The SharpDevelop and Microsoft Visual 
Studio development environments are used to create the Packages automatically when compiling. 

Do not change the files manually, always use the Add-In Utility. 

CONTENT OF THE ADD-IN PACKAGE 

The Add-In Package contains: 

 Content.xml: XML metadata file with contents of the package. 

 Binary.zip: ZIP file with the binary files. 
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XML-FILE 

The content of an Add-In Package is listed in its own XML file (Content.xml). 

BINARY FILES 

Binary files are saved in their own ZIP file. This file must contain all components that are needed on 
another system to execute the Add-In. Direct and indirect references to .NET Assemblies. In doing so, 
only external Assemblies are included. Assemblies that are not part of the .NET Framework Class Library 
or are installed during the zenon installation. 

 Ensure that you have all the licenses required for this. 

 Dynamically-loaded .NET Assemblies are not included in the metadata of .NET Assemblies. 

  Informations 

COPA-DATA accepts no liability and offers not technical support for external 
Libraries. 

 
 

3.4.4 SharpDevelop 

SharpDevelop (also #develop) is an open-source development environment that is based on Microsoft's 
.NET platform. SharpDevelop is supplied with zenon and is also installed during the installation of zenon. 

 You can find the respective current version and the official documentation for SharpDevelop 
online at: www.icsharpcode.net/opensource/sd/ (http://www.icsharpcode.net/opensource/sd/). 
 

Create add-in package with SharpDevelop 

To create an Add-In Package with SharpDevelop: 

1. Start SharpDevelop by 

 selecting the Extras -> Open add-in editor ... menu in the zenon Editor, or 

 selecting, in the Startup Tool, under Tools, the SharpDevelop IDE linking 

2. Select File -> New Solution and select, under C# -> SCADA Add-Ins or VB -> SCADA Add-Ins, a 
corresponding template; create a new project based on this: 

 Editor Service Extension (à la page 17) 

 Editor Wizard Extension (à la page 17) 

 Project Service Extension (à la page 18) 

http://www.icsharpcode.net/opensource/sd/
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 Project Wizard Extension (à la page 18) 

 All examples used in this help chapter are based on C#. 

3. Add your code, references, etc. 

4. Compile the project. 
The Add-In Package with the file suffix *.scadaAddIn is created in the output window of the 
project.  
This is called, depending on the configuration ...bin\Debug\ or ...bin\Release\. 

5. Import the add-in package in the Editor, see the following in relation to this: 

 Installing and manging add-ins for the Editor (à la page 30) 

 Installing and manging add-ins for Runtime (à la page 35) 
 

Deploying and debugging add-ins 

DEBUGGING IN THE EDITOR 

To debug an Add-In in the Editor, proceed as follows: 

1. Start the zenon Editor. 

2. Start SharpDevelop by 

 selecting the Extras -> Open add-in editor ... menu in the zenon Editor, or 

 selecting, in the Startup Tool, under Tools, the SharpDevelop IDE linking 

3. Open the project. 

4. In the project settings in SharpDevelop, go to the Add-In tab. 

5. Select Editor under Debug Target. 

6. Start the debugging using F5 or Debug -> Run. 

7. The Add-In project is compiled and deployed in the Editor. 

 The Add-In is copied to the 
%ProgramData%\COPA-DATA\zenon760\EditorAddInCache directory in the 
process. 

To remove it from the Editor again, proceed as outlined in the Installing and managing Add-Ins 
for the Editor (à la page 30) chapter. 
If there is already an Add-In with the same ID, this is replaced. 

8. Debug the Add-In. 
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DEBUGGING IN RUNTIME 

To debug an Add-In in Runtime, proceed as follows: 

1. Start the zenon Runtime. 

2. Start SharpDevelop by selecting, in the Startup Tool under Tools, the SharpDevelop IDE link 

3. Open the project. 

4. In the project settings in SharpDevelop, go to the Add-In tab. 

5. Select, under Debug Target, the corresponding project in Runtime in which you want to debug 
the Add-In. 

6. Start the debugging using F5 or Debug -> Run. 

7. The Add-In project is compiled and temporarily deployed in the selected zenon project. 

 The Add-In is temporarily copied to the 
...\RT\FILES\zenon\system\AddInCache\... directory in the process. 

It is removed again after Runtime is closed. 

To install an Add-In on a permanent basis, import it as described in the Installing and managing 
Add-Ins for Runtime (à la page 35). 

8. Debug the Add-In. 

  Informations 

As an alternative to the methods described, you can also debug your Add-Ins using 
Debug -> Attach to Process. In doing so, connect from the corresponding Add-In 
project in SharpDevelop to the process in the zenon Editor or Runtime. 

 
 

3.4.5 Microsoft Visual Studio 

Create add-in package with Visual Studio 

To create an Add-In Package with Visual Studio: 

1. Start Visual Studio. 

2. Install the Visual Studio Developer Tools. 
 This can be downloaded from the Visual Studio Marketplace 

https://marketplace.visualstudio.com/. 

3. Select File -> New Project and select, under Templates -> Visual C# -> SCADA Add-Ins or 
Templates -> Visual Basic -> SCADA Add-Ins, a corresponding template; create a new project 
based on this: 

https://marketplace.visualstudio.com/
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 Editor Service Extension (à la page 17) 

 Editor Wizard Extension (à la page 17) 

 Project Service Extension (à la page 18) 

 Project Wizard Extension (à la page 18) 

 All examples used in this help chapter are based on C#. 

4. Add your code, references, etc. 

5. Create the project. 

6. The Add-In Package with the file suffix *.scadaAddIn is automatically created in the output 

folder of the project (...bin\Debug\ or ...bin\Release\ depending on configuration). 

7. Import the add-in package in the Editor, see the following in relation to this: 

 Installing and manging add-ins for the Editor (à la page 30) 

 Installing and manging add-ins for Runtime (à la page 35) 
 

Deploying and debugging add-ins 

DEBUGGING IN THE EDITOR 

To debug an Add-In in the Editor, proceed as follows: 

1. Start the zenon Editor. 

2. Start the debugging in Visual Studio using F5 or Debug -> Start Debugging. 

3. The Add-In project is compiled and deployed in the Editor. 

 The Add-In is copied to the 
%ProgramData%\COPA-DATA\zenon760\EditorAddInCache directory in the 
process. 

To remove it from the Editor again, proceed as described in the Installing and managing Add-Ins 
for the Editor (à la page 30) chapter. 

4. Debug the Add-In. 

  Informations 

As an alternative to the method described, you can also debug your Add-Ins by means of 
Debug -> Attach to Process. In doing so, connect from the corresponding Add-In 
project in Visual Studio to the zenon Editor process. 

Recommended debugger type (Debugger Type): Managed mit CLR 4.0 
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DEBUGGING IN RUNTIME 

To debug an Add-In in Runtime, proceed as follows: 

1. Compile the Add-In and import it as described in Installing and managing Add-Ins for Runtime (à 
la page 35). 

2. Start the zenon Runtime. 

3. In Visual Studio, select Debug -> Attach to Process 

4. Select the zenon Runtime process (Zenrt32.exe) and click on Attach 

5. Debug the Add-In. 

 
 

3.4.6 Source code management 

To administer the source code, the use of a version control system - such as TFS, GIT or SVN - is 
recommended. 

Attention 

In contrast to VSTA and VBA, the Source Code of Add-Ins is not saved and administered in 
the zenon project. 

 

 

 
 

3.4.7 Add-in analysis and packaging utility (AddInUtility) 

The AddInUtility tool is automatically called up when compiling Add-Ins and has the following tasks: 

 Analysis of the dependencies 

 Packaging of Add-Ins 

A package contains the Add-In Assembly and an XML file with the extension *.scadaAddin, which 
contains the metadata for the Add-In. 
 

Command line tool AddInUtility.exe 

The AddInUtility packages Add-Ins using the command line. 
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Syntax: AddInUtility.exe [-[shortTerm] or [/ or --][longTerm] [argument value]] ... 

 Arguments are case sensitive 

 Values are case sensitive if marked as such. 

 Arguments can be stated in any desired order. 

Argument Description 

--action  
(-a) 

Action that is to be carried out. 
Possible values: 

 BuildPackage 

 GetPackageInfo 

Mandatory information. 

--path 
(-p) 

Path information. 

Required information for: 

 action = BuildPackage: Path to add-in assembly file. 

 action = GetPackageInfo: Path to Add-In Package file. 

Mandatory information. 

--targetDir 
(-t) 

Target folder. 

Required information for: 

 action = BuildPackage: Path to the folder in which the add-in 
package is created. 

Default: current folder 

Examples 

 Creates an Add-In Package (arguments written out in full):  
AddInUtility.exe --action BuildPackage --path C:\Addin.dll --targetDir C:\Directory\ 

 Creates an Add-In Package (arguments in abbreviated form):  
AddInUtility.exe -a BuildPackage -p C:\Addin.dll -t C:\Directory\ 

 Returns information about the given Add-In Package:  
AddInUtility.exe -a GetPackageInfo -p C:\Directory\Addin.scadaAddIn 

 

3.4.8 Action in the event of reloading 

zenon offers a reload function for projects that support hot plugging or the updating of amended 
project files in runtime. According to the functions of the Add-Ins triggered, the sequence of activities 
for VSTA and VBA is as follows: 

1. Pre-reload VSTA  

2. Stop of Service Extensions  



Add-Ins 

 

 

26 

 

 

3. Reload VBA  

4. Start of Service Extensions  

5. Post-reload VSTA 

Add-Ins behave like VSTA and provide a Pre-reload-function and a Post-reload-function. These are used 
after the VSTA Pre-reload and before reloading of VSTA and as a Wrapper for the VBA reload function. 
Reloading is delayed until the execution of Wizard Extensions has been completed.  

 If you want to use the reload functionality, avoid Wizard-Extensions that block or 
run for a long time. 

When being loaded again, all running service expansions are restarted. Newly-installed service 
expansions are started after the restart if the DefaultStartMode is set to automatic. 
 

3.4.9 Isolation 

All Add-Ins are executed in an isolated memory area (App-Domain). As a result, different versions of the 
same Assemblies can be loaded at the same time. 
 

3.5 Use of add-ins in Editor and Runtime 

Add-Ins provide project configuration aids in the zenon Editor and supplement the functionalities of 
zenon in Runtime. 

You can find Add-Ins: 

 For the Editor in the Extras menu under the following entries: 

 Manage Editor Add-Ins 

 Start Editor Wizards 

 Manage Editor services... 

 For Runtime in the Programming interfaces - Add-Ins node 

ADD-INS FOR EDITOR AND RUNTIME 

 Add-Ins for the Editor (à la page 30): 
Add-Ins are imported, installed and can be used in the Editor. 
Administration (à la page 30) is carried out by means of entries in the Extras menu. 

 Add-Ins for Runtime (à la page 35): 
Add-Ins are imported; when starting Runtime, they are activated automatically and can then be 
used. 
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The administration (à la page 35) is carried out using the detail view of the programming 

interface - Add-Ins node in the project tree. 

Add-Ins are available as: 

 Wizard: Is called up by the user and closed again after the task has been completed. 
For details on the wizards supplied with zenon, read the Wizards manual. 

 Service: Can be started automatically or manually and runs in the background. 

Add-Ins can: 

 Be supplied with zenon 

 Be developed by integrators and provided to their customers 

 Developed by customers themselves 

FILTER AND SORT THE LIST OF ADD-INS AND SERVICES 

To filter a list in the detail view or in a dialog: 

1. Click in the filter line of the desired curve. 

2. Enter the filter criteria.  
Placeholders can be used. 

 ?: Placeholder for precisely one desired character. 

 *: Placeholder for as many characters as desired. 

3. Several filters can be combined. 

 To remove all filters, click on the corresponding symbol in the tool bar. 

To sort the list: 

1. Click on the column title of the column according to which sorting is to take place. 

The binoculars symbol shows the column according to which sorting takes place. 

The list is sorted according to the column. 

An arrow shows whether the sorting is ascending or descending. 

2. To change the sorting sequence, click on the column title again. 

BACKING UP AND RESTORING 

The following is applicable for the backup and restoring of Add-Ins: 

 When securing the workspace, Editor Add-Ins are not saved. 

 Installed Add-Ins for the Editor are in the 
%ProgramData%\COPA-DATA\zenon760\EditorAddInStore directory and can be 
backed up manually if required. 
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 Add-In Packages of projects are also backed up when creating project and workspace backups 
and are restored again when read back in. 

HISTORY OF CHANGES 

If the change history has been activated for the project, entries for the change history are generated in 
the project when installing and uninstalling Add-In Packages. 
 

3.5.1 Activate add-ins in zenon 

The use of Add-Ins is activated in zenon6.ini. The following entry must be present for this: 

[AddIns] 

ON=1 

This entry is activated by default after the installation of zenon. 

If VBA/VSTA for zenon (à la page 87) is deactivated, Add-Ins are also deactivated. 
 

3.5.2 Action during installation 

Add-Ins can be used in the Editor or in Runtime. 
The following is applicable when installing Add-Ins: 

1. New installation: 
The selected Package is saved in the AddInStore folder. 

 Folder for installation in the Editor (à la page 30): 
%ProgramData%\COPA-DATA\zenon760\EditorAddInStore 

 Folder for installation in Runtime (à la page 35): 
...\RT\FILES\zenon\system\AddInStore\... 

The Add-In ID is used as a file name and the .scadaAddIn file suffix is added. 

2. New installation with the same ID: 
The pre-existing Add-In is replaced. 

3. During installation, pre-existing files of other versions (higher or lower) are replaced. 
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  Informations 

The Add-In ID is unique for each Add-In and is defined using a .NET attribute in the 
AddInInfo.cs file. 

Example (Add-In ID = AddInProject): 

// Declares that this assembly is an add-in 

[assembly: Addin("AddInProject", "1.0")] 

 
 

3.5.3 Add-ins node in the Project Manager 

In the project tree of the Project Manager, it is possible to import add-ins under the Programming 

interfaces node item. You can find details in the Project tree context menu (à la page 29) chapter. 
 

Project tree context menu 

Right-click in the Add-Ins symbol in the Programming interfaces node in the project tree to open a 
context menu: 

Entry Description 

Import Add-In... Opens the dialog to import an Add-In Package that is to be used in 
Runtime. 

 The package is only imported, not installed. Installation is 
carried out in Runtime. 

Editor profile Ouvre la liste déroulante contenant les profils Editor prédéfinis. 

Help Ouvre l'aide en ligne. 

 
 

Detail view of context menu and toolbar 

In the detail view of the Add-In node in the project tree, Add-Ins that are used in Runtime are displayed 
and administered by means of a tool bar and a context menu. 

 

Entries in the context menu and meaning of the symbols from left to right: 
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Symbol/Entry Description 

Import Add-In  Opens the dialog to import an Add-In Package that is to be used in 
Runtime. 

 The package is only imported, not installed. Installation is 
carried out in Runtime. 

Delete Uninstalls and deletes the selected Add-In after requesting 
confirmation. 

Remove all filters Removes all filters that are currently applied in the list of Add-In. 

Properties Ouvre la fenêtre de Propriétés. 

Help Ouvre l'aide en ligne. 

 
 

3.5.4 Use in the zenon Editor 

Add-Ins for use in the zenon Editor are imported, installed and administered in the Editor. 

Add-Ins for the Editor can contain the following: 

 Editor Wizard Extensions (à la page 17), which are started manually via the Extras -> Editor 

Wizards menu item. 

 Editor service extensions (à la page 17) are started if the workspace is loaded and its start mode 
is set to automatic. It is stopped as soon as the workspace is closed. 

Installed Add-Ins for the Editor are saved under: 
%ProgramData%\COPA-DATA\zenon760\EditorAddInStore 
 

Installing and manging add-ins for the Editor 

In the zenon Editor, Add-Ins can be imported, installed and administered. 

 Only Add-Ins with Editor Extensions can be imported and installed. If no Editor Extensions are 
found during import, a corresponding warning is shown. 

IMPORTING AND INSTALLING ADD-INS 

To import and install an Add-In: 

1. Open the Extras menu. 

2. Select the Manage Editor Add-Ins entry. 
The dialog to manage Add-Ins is opened. 
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3. Click on the Import and Install symbol, select the entry in the context menu or press the 
Insert key. 

The dialog (à la page 32) to select an Add-In is opened. 

4. Select the desired Add-In. 

5. Click on Open. 

The Add-In is imported and installed. 

6. Click on Close to close the dialog. 

UNINSTALL AND DELETE ADD-IN 

To uninstall and delete an Add-In: 

1. Open the menu Tools. 

2. Select the Manage Editor add-ins entry. 
The dialog to manage Add-Ins is opened. 

3. Select an Add-In. 

4. Click on the Uninstall and delete symbol, select this entry in the context menu or press the 
Delete key. 

A dialog requesting confirmation is opened. 

5. Confirm this when requested to do so. 

The Add-In is uninstalled and deleted. 
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Manage Editor Add-Ins dialog 

 

Option Description 

Toolbar Contains symbols for: 

 Importing, installing and deleting Add-Ins 

 Removing the filter 

 Help display 

List of the Add-Ins Shows all installed Add-Ins.  
Information on the following is shown: 

 Name 

 Description 

 Version 

 Whether source code is included. 

Elements can be shown filtered and sorted. 

Close Closes the dialog. 

Help Ouvre l'aide en ligne. 

TOOLBAR AND CONTEXT MENU 

 

Meaning of the entries in the context menu and the symbols, from left to right: 
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Symbol Description 

Import and install Opens the dialog to select an Add-In. This can be imported and 
installed. 

Uninstall and delete Uninstalls and deletes the selected Add-In after requesting 
confirmation. 

Remove all filters Removes all filters that are currently applied in the list of Add-Ins. 

Help Ouvre l'aide en ligne. 

 
 

Manage Editor services 

Add-In Extensions that run in the Editor as services are managed using their own dialog. 

To mange Editor services 

1. Open the menu Tools 

2. Select the Manage Editor services... entry. 

The dialog to manage the services is opened. 

MANAGE EDITOR SERVICES DIALOG 

 



Add-Ins 

 

 

34 

 

 

Option Description 

Toolbar Contains symbols for: 

 Starting and stopping the services 

 Setting the start type 

 Removing the filter 

 Help display 

List of services Shows all installed Services. Information on the following is shown: 

 Name 

 Description 

 Start type 

 Status 

Elements can be shown filtered and sorted. 

Close Closes the dialog. 

Help Ouvre l'aide en ligne. 

TOOLBAR AND CONTEXT MENU 

 

Meaning of the entries in the context menu and the symbols, from left to right: 

Symbol Description 

Start service Starts the selected service. 

Stop service Stops the selected service. 

Start type manually Sets the start type for the selected service to manual. 

Start type automatically Sets the start type for the selected service to automatic. 

Remove all filters Removes all filters that are currently applied in the list of services. 

Help Ouvre l'aide en ligne. 

BEHAVIOR FOR START AND STOP 

If the automatic start mode has been selected for a Workspace Service Add-In, it is loaded before the 
Event OnWorkspaceStartup when the Editor is started. When the Editor is closed, it is stopped after the 
event OnWorkspaceExit. The add-in can thus react to the zenon events. 
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3.5.5 Use in zenon Runtime 

Add-ins for use in zenon Runtime are imported and administered in the Editor. They are automatically 
installed when Runtime starts, in order to be able to be executed in Runtime. Each zenon project 
manages its own add-ins. 

 Add-Ins are copied to the following folder when creating the Runtime files for a project: 
...\RT\FILES\zenon\system\AddInStore\... 

 The Add-Ins are installed in the following folder when starting the Runtime: 
...\RT\FILES\zenon\system\AddInCache\... 

Furthermore, in doing so: 

 Amended Add-In Packages are updated. 
The sync is carried out using the change date of the Add-In Package. 

 Add-Ins that are no longer present are deleted. 

 Project Service Extensions (à la page 18) with the start mode set to automatic are instanced 
and started automatically. 

 Project Wizard Extensions (à la page 18) can be executed using the zenon Exécuter 

l'extension du wizard project function. 

  Conseil 

Vous pouvez accéder au dossier du Runtime en sélectionnant le projet dans Editor et 
en appuyant sur la combinaison de touches Ctrl+Alt+R. 

 
 

Installing and manging add-ins for Runtime 

Add-Ins for Runtime are imported into the Editor and automatically installed when Runtime is started. 
Import is carried out by means of the context menu or the tool bar in the detail view. 

IMPORT ADD-IN 

To import an Add-in : 

1. In the Editor, open the detail view for Add-Ins in the project tree. 

2. Click on the Import Add-In symbol, select this entry in the context menu or press the Insert 
key. 

The dialog to select an Add-In is opened. 

3. Select the desired  Add-In. 

4. Click on Open. 
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The Add-in is imported. 

 

 Only once the Runtime files have been created is the Add-In saved in the Runtime files. 
Save folder: ...\RT\FILES\zenon\system\AddInStore\... 

 When starting or reloading Runtime, it is installed, modified or updated in the following 
folder: 

...\RT\FILES\zenon\system\AddInCache\... 

During modification, the sync is carried out using the time stamp of the Add-In Package. 

5. Click on Close to close the dialog. 

 Only Add-Ins with Project Extensions can be imported and installed. If no Project Extensions are 
found during import, a corresponding warning is shown. 

INSTALLING AND UNISTALLING ADD-INS 

Add-Ins are automatically installed or updated when Runtime is started. 

Procedure: 

 When Runtime is started, the Packages installed for the project are compared to those in the 
Editor. 

 Comparison is carried out using the time stamp. 

 With different time stamps or new Packages, the Package is installed. A pre-existing Package 
with the same name is overwritten. 

 If there is no longer a Package in the Editor that is present in Runtime, it is also removed from 
Runtime. 

DELETE ADD-IN 

To delete an Add-In: 

1. In the Editor, open the detail view for Add-Ins in the project tree. 

2. Select an Add-In. 

3. Click on the Delete symbol or press the Delete key 

A dialog requesting confirmation is opened. 

4. Confirm this when requested to do so. 

The Add-In is deleted.  
After the Runtime files have been compiled the next time, it is uninstalled when Runtime is 
reloaded or restarted. 
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3.6 Switch/conversion from VSTA 

EDITOR 

To convert existing VSTA functionality from the Editor, proceed as follows. 

FUNCTIONALITY FROM WIZARDS 

Functionality that has been implemented using a VSTA wizard can only be implemented by means of 
Editor Wizard Extensions (à la page 17). 

Copy your existing code to an Editor Wizard Extension and make changes to the code if necessary. 

Use the Editor wizards... dialog to start the wizard. 

FUNCTIONALITY FROM VSTA EVENTS 

Functionality that is executed on an event-triggered basis (such as via .OnElementCreated, .OnPreBuild) 
can now be implemented using Editor Service Extensions (à la page 17). 

To do this, copy the code to initialize the event handler to the Start method of the Editor Service 
Extension. You copy the code for release into the Stop method. 

For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must be set 
in the Extension. The start mode can also be changed with the Manage Editor services (à la page 33) 
dialog. 

FUNCTIONALITY FROM VSTA MACROS. 

Functionality that is executed using the Execute VBA/VSTA macro combobox can now be implemented 
using Editor Wizard Extensions (à la page 17). 

To do this, copy the code from your existing VSTA macro in to the Run method of the Editor Wizard 
Extension and make changes to the code if necessary. 

Use the Editor wizards... dialog to execute the code. 

RUNTIME 

To convert existing VSTA functionality from Runtime, proceed as follows. 
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FUNCTIONALITY FROM VSTA MACROS. 

Functionality that was executed by means of the Exécuter macro VSTA function can now be 
implemented by means of Project Wizard Extensions (à la page 18). 

To do this, copy the code from your existing VSTA macro in to the Run method of the Project Wizard 
Extension and make changes to the code if necessary. 

To start the Project Wizard Extension, use the zenon Exécuter l'extension du wizard project function. 

FUNCTIONALITY FROM VSTA EVENTS 

Functionality that is executed on an event-triggered basis (such as via .DynPictures().Open, 
.Alarm().AlarmComes) can now be implemented using Project Service Extensions (à la page 18). 

To do this, copy the code to initialize the event handler to the Start method of the Project Service 
Extension. You copy the code for release into the Stop method. 

 For automatic start, the DefaultStartMode=DefaultStartupModes.Auto attribute must be set 
in the Extension. 
 

4. Liste de macros 

Vous pouvez utiliser le VBA et VSTA pour étendre les fonctions de zenon. L'utilisation de macros avec 
zenon est décrite. 

MENU CONTEXTUEL 

Élément de menu Action 

Ouvrir l'éditeur VBA Ouvre l’éditeur VBA. 

Exporter VBE tous Ouvre la boîte de dialogue de sélection du répertoire de stockage des 
données VBE exportées. 

Importer VBE Ouvre la boîte de dialogue de sélection du fichier d'importation de 
données VBE. 

Profils Editor Ouvre la liste déroulante contenant les profils Editor prédéfinis. 

Aide Ouvre l’aide en ligne. 
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  Informations 

Si des macros VBA sont modifiées dans l'Éditeur, 

 Les fichiers de Runtime sont compilés et transférés vers le Runtime 

 Le Runtime est actualisé 

 Les éléments VSTA sont également actualisés, même si aucune modification n'a été 
effectuée dans VSTA 

VBA démarre le même environnement de développement pour Espace de travail et le projet.  
Pour ouvrir l'Éditeur VBA : 

1. Dans zenon Editor, accédez au nœud Interfaces de programmation. 

2. Expand the view of this node by clicking on [+]. 
The view of the node is expanded. 

3. Right-click on Macro list 

4. Sélectionnez Open VBA Editor... (Ouvrir l'Éditeur VSTA) dans le menu contextuel. 

 : appuyez sur les touches . 

 
 

4.1 Vue de détail de la barre d'outils et du menu contextuel VBA 

BARRE D'OUTILS 
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Élément de menu Action 

New VBA macro (Nouvelle 

macro VBA) 
Crée une nouvelle macro et ouvre l'éditeur de macros. 

Ouvrir l'éditeur VBA Ouvre l’éditeur VBA. 

Enregistrer Enregistre les macros. 

Supprimer Supprime l'élément sélectionné. 

Exporter VBE tous Ouvre la boîte de dialogue de sélection du répertoire de stockage des 
données VBE exportées. 

Importer VBE Ouvre la boîte de dialogue de sélection du fichier d'importation de 
données VBE. 

Renommer Permet de renommer la macro sélectionnée. 

Aide Ouvre l’aide en ligne. 

MENU CONTEXTUEL MODULE 

Élément de menu Action 

Ouvrir l'éditeur VBA Ouvre l’éditeur VBA. 

Enregistrer Enregistre les macros. 

Exporter VBE tous Ouvre la boîte de dialogue de sélection du répertoire de stockage des 
données VBE exportées. 

Importer VBE Ouvre la boîte de dialogue de sélection du fichier d'importation de 
données VBE. 

Aide Ouvre l’aide en ligne. 

MENU CONTEXTUEL MODULE 

Élément de menu Action 

New VBA macro (Nouvelle 

macro VBA) 
Crée une nouvelle macro et ouvre l'éditeur VBA. 

Aide Ouvre l’aide en ligne. 
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MENU CONTEXTUEL MACRO 

Élément de menu Action 

Édition Ouvre une macro dans Editor pour l'édition. 

Alternative : Touche Entrée ou double-clic. 

Supprimer Supprime la macro. 

Alternative : Touche Suppr. 

Renommer Ouvre les éléments de liste pour l'édition. 

Alternative : La touche F2 

Aide Ouvre l’aide en ligne. 

BARRE D’OUTILS 

Les macros créées en langage VBA peuvent être gérées via l’élément de barre d’outils Liste de macros. 
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Symbole  

(de gauche à droite) 

Fonction 

Recharger la liste des macros 

VBA/VSTA 
Charge toutes les macros Public Sub Name () incluses dans 
myWorkspace et les modules dans la liste déroulante de la 
barre d’outils. 

Rechercher une macro Vous pouvez rechercher des macros par l’intermédiaire d’un champ 
de saisie ou d’une liste déroulante. La largeur de la liste déroulante 
est déterminée en fonction de l’élément le plus large.  

Liste déroulante Macros Contient toutes les macros chargées et vous permet de les 
sélectionner.  

Exécuter la macro sélectionnée  Exécute la macro sélectionnée dans la liste déroulante.  

Exécuter la macro associée no. 

<x>  
Exécute la macro associée au symbole. 

Attribuer des macros  Ouvre la boîte de dialogue d’association de macros. Jusqu’à 5 
macros peuvent être associées aux symboles 1 à 5. 

VBA Filtres pour macros VBA. Seules les macros VBA sont affichées. 

VSTA Filtres pour macros VSTA. Seules les macros VSA sont affichées. 

TOUT Annule le filtre actuel et affiche toutes les macros.  

AZ Trie les macros par ordre croissant, de 0 à 9 et de A à Z. 

ZA Trie les macros par ordre décroissant, de Z à A et de 9 à 0. 

Options pour la barre de 

symboles  
Cliquez sur la flèche pour ouvrir le sous-menu : 

Active : la barre d'outils est affichée. 

Si la barre d’outils n’est pas affichée, elle peut être activée en 
sélectionnant le menu Options -> Barre d’outils. 

  Si la barre d’outils est positionnée librement 
(c’est-à-dire dissociée d’Editor), les options ne sont pas affichées. 
Pour fermer la barre d’outils, cliquez sur le bouton X. 

  

  Informations 

Si la boîte de dialogue d’association de macros ne contient pas toutes les macros de 
myWorkspace, exécutez la fonction Recharger la liste des macros VBA dans la barre 
d’outils.  
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4.2 VBA sur les systèmes 64 bits 

zenon est compatible avec les systèmes 64 bits depuis la version 7.10. La version de VBA utilisée est 
désormais la version 7.1. zenon est également disponible dans une version 64 bits. Si, dans le code VBA, 
des fonctions de Windows API ou d'autres fichiers DLL importés sont utilisées, ces exécutions doivent 
être adaptées à la version 64 bits. En règle générale, les dispositions suivantes s’appliquent : Un fichier 
VBA créé pour une version 32 bits ne peut pas être utilisé sans modification dans une-version 64 bits. 

Certaines définitions/fonctions sont disponibles dans VBA, permettant ainsi de créer du code 
compatible 32 bits et 64 bits. Par exemple : 

#if Win64 then 

Declare PtrSafe Function MyMathFunc Lib "User32" (ByVal N As LongLong) As LongLong 

#else 

Declare Function MyMathFunc Lib "User32" (ByVal N As Long) As Long 

#end if 

#if VBA7 then 

Declare PtrSafe Sub MessageBeep Lib "User32" (ByVal N AS Long) 

#else 

Declare Sub MessageBeep Lib "User32" (ByVal N AS Long) 

#end if 

Vous pouvez également consulter des notes utiles concernant le portage de code VBA 32 bits en code 
VBA 64 bits de Microsoft : 

 Microsoft Office 2010, notes concernant le portage : 
http://msdn.microsoft.com/en-us/library/ee691831.aspx 
(http://msdn.microsoft.com/en-us/library/ee691831.aspx) 

 Déclarations 32 bits et 64 bits pour appels API : 
http://www.jkp-ads.com/articles/apideclarations.as 
(http://www.jkp-ads.com/articles/apideclarations.as)p 

 

4.3 Notions fondamentales 

Décrit les notions fondamentales du langage de programmation VBA (Visual Basic for Applications) 
 

4.3.1 Les propriétés des objets 

Une propriété d'objet est un attribut de l'objet. Dans le cas de l'objet Variable, c'est par exemple, la 
valeur, le nom ou l'identification. Dans le cas d'un cercle, ce sera la position ou la couleur du cercle dans 
le synoptique. Chaque objet a au moins une propriété (généralement plus), chaque propriété ayant une 

http://msdn.microsoft.com/en-us/library/ee691831.aspx
http://www.jkp-ads.com/articles/apideclarations.as
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certaine valeur. La propriété Name est un texte, la propriété Value est une valeur entre 0 et 1000, par 
exemple. 

La particularité des propriétés est que si on change leur valeur par un programme VBA, alors on change 
le comportement ou l'apparence de l'objet. Si vous modifiez, par exemple, la propriété Value d'un objet 
Variable, la variable actuellement sélectionnée reçoit cette nouvelle valeur. Vous ne pouvez pas 
toujours changer la valeur d'une propriété. La propriété Count de l'objet variable ne peut pas être 
modifiée car elle représente le nombre de variables créées. Vous ne pouvez pas ajouter des variables en 
changeant la valeur de la propriété Count. Ainsi certaines propriétés ont l'attribut 'lecture seule', c'est à 
dire qu'elles ne sont accessible qu'en lecture. 
 

4.3.2 Les méthodes des objets 

En plus des propriétés, chaque objet peut avoir des méthodes. Une méthode n'est pas un attribut, mais 
une requête sur l'objet pour faire quelque chose. Un formulaire comporte une méthode Show (Afficher). 
Qu'est-ce que cela fait ? Cela demande au 'form' de s'afficher à l'écran. De façon similaire, le formulaire 
disparaît si l'on utilise la méthode globale Unload. 

L'avantage des méthodes est que le programmeur n'a pas à connaître la structure de l'objet, et par 
dessus tout, il n'a pas la possiblité de changer les données internes de l'objet. 

L'exécution de la méthode Show (Afficher) ou Unload (Masquer) fonctionne de la façon suivante : 

frmSollwert.Show ou Unload frmSollwert 

Si vous voulez ouvrir un autre 'form', la méthode est la même, vous avez juste à changer le nom du 
'form' (nom de l'objet). 

frmChange.Show ou Unload frmChange 

Donc une seule et même méthode peut être utilisée pour chacun des objets. Mais tous les objets n'ont 
pas des méthodes. 
 

4.3.3 Les événements des objets 

Pour 90% des choses que vous aurez à faire avec les objets, vous utiliserez les propriétés et les 
méthodes, mais il y a aussi un troisième type d'attribut que les objets peuvent avoir : les événements. 
Certains objets du système de contrôle peuvent réagir à des événements. Les événements se produisent 
de manière indépendante durant l'utilisation de zenon. 
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  Exemple 

Lorsqu'un synoptique est ouvert, un événement d'ouverture est déclenché sur l'objet 
synoptique correspondant. En tant que programmeur, vous pouvez ajouter des 
commandes dans la procédure d'événement (procédure exécutée lorsque l'événement 
survient), qui définissent ce qui doit arriver dans ce cas. Un exemple lors du changement 
de la valeur d'une variable. Vous pouvez créer un événement qui réagit au changement 
de valeurs d'une variable. 

 
 

4.3.4 Structure d'objet VBA dans zenon 

En termes simples, il existe une liste d'objets et des occurrences multiples d'objets dans la structure du 
projet. 

Exemple : 

Projets – Projet 

Variables – Variable 

Eléments – Elément 

Vous pouvez obtenir davantage d'informations concernant le modèle d'objet : 

 Dans l'aide de VBA 

 



Liste de macros 

 

 

46 

 

 

 Dans la présentation graphique, dont vous pouvez obtenir l'impression intégrale auprès de 
COPA-DATA. 

 

 Dans le navigateur d'objets de VBA 
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4.3.5 Comment utiliser les macros VBA 

Pour créer une nouvelle macro dans la fenêtre Project info de la page de propriétés Macro Browser, 
sélectionnez l'événement auquel la nouvelle macro doit être exécutée. 

 

Cliquer avec le bouton droit de la souris sur cet événement, ouvre un menu. 

Sélectionnez l'entrée 'Nouvelle macro...' zenon génère alors une procédure : 

Public Sub LeftClickUp_Sollwert(obElem As Element)  

End Sub 

Si une macro existe déjà, elle peut être éditée, supprimée ou renommée en cliquant dessus avec le 
bouton droit de la souris. 

Attention 

Si vous sélectionnez l'élément de menu Rename macro (Renommer la macro), faites 
attention à ne pas modifier le nom de l'événement, par exemple LeftClickUp_. Sinon cette 
fonction ne sera pas exécutée. De plus, vous devez modifier à la main le nom de la macro 
dans l'éditeur VBA. 

Après avoir codé le code source à exécuter dans la procédure générée par zenon, la macro doit être liée 
à l'élément. 

Sélectionnez l'élément dans le synoptique pour afficher ses propriétés. 

Dans les propriétés VBA / Evénements ..., la macro peut être liée à l'élément graphique. 

En runtime, lorsque l'utilisateur clique avec le bouton gauche de la souris sur l'élément, l'événement 
LeftClickDown est exécuté et s'il y a une macro associée, elle est exécutée. 
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Insérer des macros existantes 

Pour insérer des macros existantes dans un autre projet, vous pouvez suivre les instructions suivantes : 

1. Dans l'éditeur VBA, exportez tous les 'forms' et 'modules' et importez-les dans l'autre projet. 

2. Les macros dépendants des événements, dans ModuleElement.bas, ne sont pas, pour le 
moment, affichées dans l'explorateur de macros. Donc ces macros doivent être créées dans 
l'explorateur de macros. 

Le moyen le plus facile est d'utiliser le nom de la macro existante. 

Par exemple :  
LeftClickUp_ DateSet2   
LeftClickUp_ DateSet4   
LeftClickUp_ TimeSet   
Draw_ Date2   
Draw_ Date4   
Draw_ Time 

3. Lors de la création de macros, zenon génère des procédures avec le même nom que les macros 
existantes. Vous devez détruire ces macros générées. 

4. Connectez les macros à un élément dynamique comme vous le faites habituellement. 
 

4.3.6 Comment insérer un élément ActiveX dans zenon ? 

Un élément ActiveX est dessiné dans le synoptique comme tous les autres éléments dynamiques ; une 
boîte de dialogue s'ouvre, dans laquelle vous sélectionnez le contrôle ActiveX que vous désirez utiliser. 
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 Après avoir sélectionné l'élément dans la liste, vous pouvez lui associer des variables. Pour cela, 
cliquez sur le bouton Variable et sélectionnez une variable ou créez-en une nouvelle. 

 Dans l'étape suivante, nous donnons un nom d'objet à l'élément ActiveX pour pouvoir y accéder 
en VBA. 

 Dans notre exemple, nous lui donnons le nom d'objet Slide6_DW18, car c'est un ActiveX de type 
Slider lié à la variable Doubleword18. 

 Maintenant l'élément Slider doit être activé et édité dans l'éditeur VBA. 

 Pour cela, nous créons une nouvelle macro, comme indiqué au chapitre Comment utiliser les 
macros VBA (à la page 47). 

La macro Init_Slider passe l'élément à initialiser au sous-programme Init_Slider de l'objet thisProject 
qui contient les données du projet courant. 

Public SubInit_Slider(obElem AsElement)  

thisProject . Init _ Slider obElem  

End Sub   

Comme pour la macro Init_Slider, la macro Draw_Slider passe l'élément au sous-programme 
Draw_Slider de thisProject. 

Public Sub Draw_SliderValue (obElem As Element, ByVal hdc As OLE _ HANDLE )  

thisProject.Draw_Slider obElem  

obElem.Draw hdc  

End Sub 

Le code suivant est ajouté dans la partie thisProject. 

Public Declarations  

Public WithEvents obSlider As Slider  

Public obSliderPV As Variable  

Public Sub Init_Slider (obElem As Element)  

Set obSlider = obElem.ActiveX 

'ActiveX existe  

If obSlider Is Nothing Then  

Exit Sub  

End If  

Set obSliderPV = obElem . ItemVariable(0)  

'La variable existe  

If obSliderPV Is Nothing Then  

Exit Sub  

End If  

obSlider.Max = obSliderPV.RangeMax  

obSlider.Min = obSliderPV.RangeMin  

obSlider.TickFrequency = 1000  

obSlider.LargeChange = 25  

obSlider.SmallChange = 1  

obSlider.Value = obSliderPV.Value 

End Sub 



Liste de macros 

 

 

50 

 

 

 

Public Sub Draw _ Slider ( obElem As Element )  

Dim vVar As Variant  

Dim obDynPic As DynPicture  

 

Set obSliderPV = obElem.ItemVariable ( 0 )  

Set obDynPic = thisProject.DynPictures. Item (BILD_1)  

'variable exists  

If obSliderPV Is Nothing Then  

Exit Sub  

End If  

 
 

4.3.7 Accès depuis un programme externe 

Pour accéder aux données de zenon depuis un programme externe comme par exemple un programme 
en Visual Basic, l'interface COM est utilisée. L'interface COM est aussi utilisé par VBA. Donc il n'y a que 
quelques petites différences auxquelles il faut faire attention. 
 

Visual Basic 6 

De façon à pouvoir accéder à l'interface COM, vous devez implémenter : 

 

Avec ce type de librairie, vous pouvez accéder aux objets de l'application dans zenon (le runtime). 

Comme dans ce cas, il n'y pas d'objet thisProject, il doit être créé pour pouvoir accéder aux données. 

Dim obProject As zenon.Project  

Set obProject = zenon.Application.Projects.Item(PROJEKTNAME) 

Si le projet VB doit être compatible avec tous les projets zenon (indépendamment du nom du projet), il 
peut être défini comme suit : 
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Set obProject = zenon.Application.Projects.Item(0) 

Après la création de l'objet projet (thisProject), vous pouvez par exemple accéder aux variables en 
lecture ou en écriture. 

Lecture : 

Value = obProject.Variables.Item(Variablenname).Value 

Écriture : 

obProject.Variables.Item(Variablenname).Value = Value 
 

4.3.8 Fonctionnalité des variables en ligne 

Vous pouvez imaginez les variables en ligne de VBA : OnlineVariable comme un container qui peut 
contenir les variables du système de contrôle (elles doivent être ajoutées dans le container). Si la valeur 
d'une des variables du container change, un événement est déclenché. 
 

Fonctionnalité de l'événement 

Si le conteneur est activé (Container.Define), toutes les variables du conteneur sont forcées une fois, 
de façon à ce que la valeur courante des variables soit connue. La procédure 
Container_VariableChange est donc exécutée pour chaque variable du container. Dès que toutes les 
variables ont été initialisées, cet événement survient toujours si une des variables du container a sa 
valeur qui change. 

On évite qu'une valeur soit lue si ce n'est pas sa valeur courante. 
 

Définir et créer un conteneur 

Définition : 

Public WithEvents Container As OnlineVariable 

Avec cette ligne de code, le container est défini. 

Créer : 

Set Container = thisProject . OnlineVariables. CreateOnlineVariables ( Container name ) 
 

Placer des variables dans le conteneur 

Container . Add Variablenname1  

Container . Add Variablenname2  

Container . Add Variablenname3  

Container . Add Variablenname4  

... 
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Répéter cette ligne pour toutes les variables à ajouter au container. 
 

Créer un événement 

Private Sub Container_VariableChange(ByVal obVar As zenon.IVariable) 

... 

End Sub 

Cet événement est créé automatiquement, lorsque que le container est sélectionné dans la liste de 
gauche en haut de l'éditeur VBA (liste des objets). La procédure ci-dessus est alors ajoutée au code 
source. obVar permet de transmettre la variable dont la valeur a changé. Lorsque cet événement 
survient, la valeur actuelle de la variable (obVar.Value) peut être lue. Référez-vous à la documentation 
sur la hiérarchie des objets VBA pour voir les propriétés et les valeurs qui peuvent être utilisées sur les 
variables. 
 

Activer un événement 

Container.Define 

Cette ligne active le 'monitoring' des variables dans le container. Lorsque vous exécutez la commande 
Define, le conteneur est actif. 
 

Désactiver l'événement 

Container.Undefine 

Cette commande permet de désactiver la surveillance dans le conteneur. L'événement (VariableChange) 
n'est plus exécuté. 
 

Suppression lors de la fermeture 

De façon à ne pas laisser des éléments en mémoire lors de la fermeture du runtime, le container doit 
être supprimé juste avant la fermeture du runtime. 

thisProject. OnlineVariables. DeleteOnlineVariables ( Container_name ) 

Tant que ce conteneur n'a pas été supprimé, il est impossible de créer un conteneur portant le même 
nom. 
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4.3.9 Liste des bits d'état 

Numéro de 
bit 

Désignation 
abrégée 

Nom long Intitulé zenon Logic 

0 M1 User status 1; for Command 
Processing: Type d'action 
"Bloquer" ; Service Tracking 
(Main.chm::/IEC850.chm::/117281.
htm) du driver IEC 850 

_VSB_ST_M1 

1 M2 État utilisateur 2 _VSB_ST_M2 

2 M3 État utilisateur 3 _VSB_ST_M3 

3 M4 État utilisateur 4 _VSB_ST_M4 

4 M5 État utilisateur 5 _VSB_ST_M5 

5 M6 État utilisateur 6 _VSB_ST_M6 

6 M7 État utilisateur 7 _VSB_ST_M7 

7 M8 État utilisateur 8 _VSB_ST_M8 

8 NET_SEL Sélectionné dans le réseau _VSB_SELEC 

9 REVISION Révision _VSB_REV 

10 PROGRESS En fonctionnement _VSB_DIREC 

11 TIMEOUT Command "Timeout exceeded" 
(command runtime exceeded) 

_VSB_RTE 

12 MAN_VAL Valeur manuelle _VSB_MVALUE 

13 M14 État utilisateur 14 _VSB_ST_14 

14 M15 État utilisateur 15 _VSB_ST_15 

15 M16 État utilisateur 16 _VSB_ST_16 

16 GI Requête générale _VSB_GR 

17 SPONT Spontané _VSB_SPONT 

18 INVALID Invalide _VSB_I_BIT 

19 T_STD_E External standard time (standard 
time) 

 up to version 7.50, this 
was the status bit T_CHG_A 

_VSB_SUWI 

20 OFF Désactivé _VSB_N_UPD 

21 T_EXTERN Temps réel - horodatage externe  _VSB_RT_E 

22 T_INTERN Informations d'horodatage internes _VSB_RT_I 

23 N_SORTAB Non triable _VSB_NSORT 

main.chm::/IEC850.chm::/117281.htm
main.chm::/IEC850.chm::/117281.htm
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24 FM_TR MD_TR;Message de défaut du 
transfo 

_VSB_DM_TR 

25 RM_TR Message de marche du 
transformateur 

_VSB_RM_TR 

26 INFO Informations de la variable _VSB_INFO 

27 ALT_VAL Valeur de remplacement _VSB_AVALUE 

28 RES28 Réservé à une utilisation interne 
(clignotement d'alarme) 

_VSB_RES28 

29 N_UPDATE Not updated (zenon network) _VSB_ACTUAL 

30 T_STD Heure d’hiver interne  _VSB_WINTER 

31 RES31 Réservé à une utilisation interne 
(clignotement d'alarme) 

_VSB_RES31 

32 COT0 Cause de transmission bit 1 _VSB_TCB0 

33 COT1 Cause de transmission bit 2 _VSB_TCB1 

34 COT2 Cause de transmission bit 3 _VSB_TCB2 

35 COT3 Cause de transmission bit 4 _VSB_TCB3 

36 COT4 Cause de transmission bit 5 _VSB_TCB4 

37 COT5 Cause de transmission bit 6 _VSB_TCB5 

38 N_CONF Confirmation négative de la 
commande par l'appareil (IEC 
60870 [P/N]) 

_VSB_PN_BIT 

39 TEST Bit de test (IEC60870 [T]) _VSB_T_BIT 

40 WR_ACK Écriture reconnue _VSB_WR_ACK 

41 WR_SUC Écriture réussie _VSB_WR_SUC 

42 NORM NORM;État Normal _VSB_NORM 

43 N_NORM État déviation normale _VSB_ABNORM 

44 BL_870 État IEC 60870 : blocked _VSB_BL_BIT 

45 SB_870 État IEC 60870 : substituted _VSB_SP_BIT 

46 NT_870 État IEC 60870 : not topical _VSB_NT_BIT 

47 OV_870 État IEC 60870 : overflow _VSB_OV_BIT 

48 SE_870 État IEC 60870 : select _VSB_SE_BIT 

49 T_INVAL Horodatage externe invalide  non défini 

50 CB_TRIP Déclenchement de disjoncteur 
détecté 

non défini 

51 CB_TR_I Détection de déclenchement de 
disjoncteur inactive 

non défini 



Liste de macros 

 

 

55 

 

 

52 OR_DRV Valeur non comprise dans la plage 
valide (IEC 61850) 

non défini 

53 T_UNSYNC ClockNotSynchronized (IEC 61850) non défini 

54 PR_NR Pas enregistré dans le Process 
Recorder 

non défini 

55 RES55 réservé non défini 

56 RES56 réservé non défini 

57 RES57 réservé non défini 

58 RES58 réservé non défini 

59 RES59 réservé non défini 

60 RES60 réservé non défini 

61 RES61 réservé non défini 

62 RES62 réservé non défini 

63 RES63 réservé non défini 

 

  Informations 

Dans les formules, tous les bits d'état sont disponibles. La disponibilité peut être réduite 
dans le cadre d'autres utilisations. 

Pour plus de détails concernant la gestion des états, reportez-vous au chapitre Gestion d'états. 
 

4.3.10 Lasso de sélection d'éléments dynamiques dans le Runtime 

Les éléments dynamiques liés à une variable ou une fonction peuvent être présélectionnés à l'aide du 
lasso dans le Runtime, et ainsi être utilisés pour des événements. 

Avec la méthode SelElements, l'utilisateur peut identifier les éléments dynamiques sélectionnés tels 
qu'ils ont été sélectionnés dans le Runtime. Ces éléments DynPicture.SelElements peuvent ensuite 
utilisés pour des événements tels que glisser-déplacer. 

SÉLECTION AVEC LE LASSO 

Pour sélectionner des éléments avec le lasso dans le Runtime, vous devez : 

 Activer la propriété Sélection multiple en runtime (lasso) dans les paramètres du projet 

 Activer la propriété Runtime/sélectionnable avec le lasso dans la propriété de l'élément 
dynamique 
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 La propriété Déplacer le gabarit avec la souris doit être activée 

There are several methods for selecting elements available in Runtime, depending on the settings for 
touch operation: 

 Touch operation deactivated or Windows 7 (Reconnaissance property deactivated or Windows 
7): 

 Left mouse click + movement: New selection is created. 

 Left mouse click + Ctrl key + movement: Selection is expanded. 

 Native Windows 8 touch operation active (Reconnaissance property on Windows 8): 

 Left mouse click + movement: Screen is moved 

 Left mouse click + Ctrl key + movement: Screen is moved. 

 Left mouse click + Shift key + movement: New selection is created. 

 Left mouse click + Ctrl key + Shift key + movement: Selection is expanded. 

Règles : 

 Only elements that are visible can be selected. 

 If a button is selected and it is clicked on, the respective function is executed. 

 If a button is clicked on with a mouse button and the mouse is moved before the mouse button 
is released, the respective function is not executed. 

 Annuler la sélection : tracez un lasso ne contenant aucun élément 
 

4.4 Macros dans l'éditeur 

Les macros peuvent être exécutées à l'aide d'une barre d'outils (à la page 57) configurable dans 
l'éditeur. A cette fin, les macros sont liées (à la page 59) avec les boutons de la barre d'outils VBA. 

En outre, les macros peuvent être exécutées manuellement à l'aide de l'éditeur VBA. 

Grâce aux assistants, les tâches de développement répétitives peuvent être exécutées, ou des projets 
entiers peuvent être créés d'un simple clic sur un bouton. Quelques exemples d'assistants sont déjà 
fournis dans zenon. Ces assistants peuvent être améliorés et complétés, si nécessaire. Ils sont utiles lors 
de la création d'un projet, lors de l'importation et l'exportation, lors de la création de variables etc. Vous 
trouvez plus de détails au chapitre Assistants. 

EVÉNEMENTS DANS L'ÉDITEUR 

Les événements dans l'éditeur forment partie de l'espace de travail VBA et permettent de réagir à des 
événements lors de la programmation de l'espace de travail, par exemple pour des assistants ou lors de 
l'utilisation de la fonction de transport distant. Par exemple : 
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 OnElementCreated 

 OnElementDeleted 

 OnElementDoubleClicked 

 OnObjectCreated 

 ... 

Vous trouverez des informations concernant tous les événements dans la rubrique d'aide du chapitre 
Objet Modèle. 
 

4.4.1 Barre d’outils Liste de macros 

Les macros créées en langage VBA peuvent être gérées via l’élément de barre d’outils Liste de macros. 
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Symbole  

(de gauche à droite) 

Fonction 

Recharger la liste des macros 

VBA/VSTA 
Charge toutes les macros Public Sub Name () incluses dans 
myWorkspace et les modules dans la liste déroulante de la 
barre d’outils. 

Rechercher une macro Vous pouvez rechercher des macros par l’intermédiaire d’un champ 
de saisie ou d’une liste déroulante. La largeur de la liste déroulante 
est déterminée en fonction de l’élément le plus large.  

Liste déroulante Macros Contient toutes les macros chargées et vous permet de les 
sélectionner.  

Exécuter la macro sélectionnée  Exécute la macro sélectionnée dans la liste déroulante.  

Exécuter la macro associée no. 

<x>  
Exécute la macro associée au symbole. 

Attribuer des macros  Ouvre la boîte de dialogue d’association de macros. Jusqu’à 5 
macros peuvent être associées aux symboles 1 à 5. 

VBA Filtres pour macros VBA. Seules les macros VBA sont affichées. 

VSTA Filtres pour macros VSTA. Seules les macros VSA sont affichées. 

TOUT Annule le filtre actuel et affiche toutes les macros.  

AZ Trie les macros par ordre croissant, de 0 à 9 et de A à Z. 

ZA Trie les macros par ordre décroissant, de Z à A et de 9 à 0. 

Options pour la barre de 

symboles  
Cliquez sur la flèche pour ouvrir le sous-menu : 

Active : la barre d'outils est affichée. 

Si la barre d’outils n’est pas affichée, elle peut être activée en 
sélectionnant le menu Options -> Barre d’outils. 

  Si la barre d’outils est positionnée librement 
(c’est-à-dire dissociée d’Editor), les options ne sont pas affichées. 
Pour fermer la barre d’outils, cliquez sur le bouton X. 

  

  Informations 

Si la boîte de dialogue d’association de macros ne contient pas toutes les macros de 
myWorkspace, exécutez la fonction Recharger la liste des macros VBA dans la barre 
d’outils.  
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4.4.2 Lier les macros 

Les macros peuvent être invoquées par l'intermédiaire d'un bouton de la barre d'outils. Cinq macros 
maximum peuvent être liées de cette manière. Le bouton Attribuer des macros permet d'ouvrir la boîte 
de dialogue d'attribution de macros. 

 

Paramètre Description 

No. de macro Le numéro de macro correspond au numéro du bouton 
de la barre d'outils. 

Cliquez sur le bouton ... pour ouvrir la boîte de dialogue 
de sélection de macro. 

OK Crée des liens avec les boutons et ferme la boîte de 
dialogue. 

Annuler Annule toutes les modifications et ferme la boîte de 
dialogue. 

Aide Ouvre l’aide en ligne. 
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Paramètre Description 

Existing selection (Sélection existante) Liste des macros pouvant être liées. 

Aucune sélection Supprime l'attribution existante pour le bouton. 

OK Attribue la macro sélectionnée au bouton. 

Annuler Annule toutes les modifications et ferme la boîte de 
dialogue. 

Aide Ouvre l’aide en ligne. 

 
 

4.5 Fonctions dans zenon 

Dans la boîte de dialogue Function selection (Sélection de fonction), vous trouverez les fonctions 
suivantes sous l'élément VBA. 

Fonction Description 

Ouvrir l'éditeur PCE Cette fonction ouvre l'éditeur du module optionnel 
Process Control Engine (PCE) 

Ouvrir l'éditeur VBA Ouvre l'éditeur VBA. 

Exécuter macro VBA Exécute une macro VBA sélectionnée. 
 L'événement VBA projet inactif est 

exécuté par le script AUTO_END_xxx. Par conséquent, 
la fonction Exécuter macro VBA de zenon n'est plus 
exécutée dans les scripts, car VBA n'est pas en cours 
d'exécution à ce stade. 

Montrer la boîte de dialogue des macros VBA Ouvre la boîte de dialogue de macros VBA. 
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4.5.1 Exécuter macro VBA 

Si vous sélectionnez la fonction Exécuter macro VBA, la boîte de dialogue suivante s'affiche. 

 

Les paramètres suivants sont disponibles : 

Paramètre Description 

Sélectionner la macro Ouvre la boîte de dialogue de sélection des macros (voir également Sélection des 
macros (à la page 62)) 

Conseil : Affiche uniquement la liste des macros VBA correspondant au nombre de 
paramètres définis dans la fonction Paramètre (voir ci-dessous). 

Paramètre Saisissez la valeur souhaitée (chaîne) pour un paramètre. 

Nouveau Cliquez sur ce bouton pour appliquer la valeur au paramètre dans la liste des 
paramètres disponibles. 

Supprimer Cliquez sur ce bouton pour supprimer l'entrée sélectionnée de la liste des 
paramètres disponibles. Vous ne pouvez supprimer qu'une entrée à la fois. 

Haut Cliquez sur ce bouton pour remonter l'entrée sélectionnée d'une place. Dans 
l'ordre des paramètres, l'entrée est déplacée d'une place vers l'avant. 

Bas Cliquez sur ce bouton pour descendre l'entrée sélectionnée d'une place. Dans 
l'ordre des paramètres, l'entrée est déplacée d'une place vers l'arrière. 

Il est possible d'ajouter des chaînes aux macros créées avec des paramètres. Ces chaînes sont 
transférées sous forme de paramètres individuels dans le Runtime lors de l'exécution de la macro. 

  Informations 

Vous devez vous assurer que le nombre de paramètres de la macro liée correspond au 
nombre de paramètres créés. 
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Sélectionner la macro 

Lorsque vous cliquez sur le bouton ..., la boîte de dialogue suivante s'affiche. 

 

Sélectionnez la macro souhaitée parmi les macros disponibles, puis cliquez sur OK. 
 

4.6 Développement d'assistants dans VBA 

Depuis la version 6, il est possible d'automatiser des projets d'ingénierie à l'aide d'assistants. Ainsi, les 
tâches récurrentes peuvent être confiées à un assistant qui exécute les actions souhaitées, telles que la 
création d'un projet ou la création de cadres et de synoptiques conformément à un standard prédéfini. 

Un autre domaine d'application des assistants est l'automatisation des modifications dans les projets 
existants, par ex. la modification des propriétés d'éléments dynamiques dans tous les synoptiques d'un 
projet existant. 

La base des assistants est le langage Microsoft Visual Basic for Applications (VBA) et le modèle d'objet 
de zenon. 

À l'heure actuelle, les assistants suivants sont disponibles : 

 Project Wizard (Assistant Projet) 

 Assistant d'importation 

 Assistant Vue globale 

 Assistant de recherche de texte VBA 

 Assistant de création de mots-clés 

 Assistant de traduction de mots-clés 

 Assistant de création de variables 
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Les assistants sont disponibles sous forme de code source VBA sur le support d'installation. Les 
nouveaux assistants peuvent être mis en œuvre dans l'environnement VBA. 

 
 

4.6.1 Utilisation d'un assistant 

L'entrée de menu Editor Assistants dans le menu Outils permet d'accéder à la sélection des assistants. 
In this dialog, all available wizards are shown according to their category. 
If wizards do not contain a category, a Not linked entry is created automatically. Dans cette catégorie, 
tous les assistants non liés sont affichés. 

 

Lorsque l'utilisateur sélectionne un assistant et clique sur le bouton OK, l'assistant sélectionné est 
exécuté. 

   Informations 

L'assistant n'est pas compatible avec les projets multi-utilisateurs. 

 
 

4.6.2 Structure d'un assistant 

Un assistant est un formulaire UserForm conservé dans le nœud spécifique à l'application du 
programme. En règle générale, le formulaire UserForm est constitué d'un élément multi-pages affichant 
les différentes étapes de l'assistant. 
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Le bouton Suivant permet d'afficher la page suivante de l'élément multi-pages. Toutes les entrées 
devant être conservées temporairement (par exemple, la création d'objets tels que les cadres, les 
synoptiques, etc.) sont déterminées lorsque l'utilisateur clique sur le bouton Terminer de l'assistant. 

  

  Informations 

Les formulaires UserForms utilisés en tant qu'assistant doivent contenir des méthodes 
publiques fournissent des informations concernant l'assistant au système de contrôle. Si 
ces routines sont manquantes dans un formulaire UserForm, celui-ci n'est pas considéré 
comme un assistant. 

 
 

4.6.3 Intégration dans VBA 

Les assistants sont conservés dans un nœud spécifique de l'application, ZWorkspace. Cet objet 
représente l'espace de travail actuellement chargé dans l'Éditeur, et est uniquement disponible dans 
l'Éditeur de zenon. 

Tous les objets dans ce projet VBA peuvent accéder à l'espace de travail actuel par le biais de l'objet 
MyWorkspace. Celui-ci est toujours lié au projet actuellement actif, accessible à l'aide de la propriété 
ActiveDocument. 

Le contenu de l'objet ZWorkspace est conservé dans le fichier ZenWorkspace.vba. Celui-ci est copié 
dans le répertoire d'installation lors de la première installation de la version 6. Ce fichier n'est pas 
remplacé lors des mises à jour ultérieures. Vous trouverez plus d'informations concernant la mise à jour 
des assistants à la fin de ce didacticiel. 

  
 

4.6.4 Développement d'un assistant 

Ce didacticiel décrit le développement d'un assistant permettant de créer des variables pour un driver 
sélectionné. 

Démarrez l'environnement VBA depuis l'Éditeur de zenon, puis accédez au dossier ZWorkspace/Forms. 
Ce fichier contient les éléments de base nécessaires au développement d'un assistant. Modifiez le nom 
du formulaire UserForm. 

Si le dossier indiqué ci-dessus n'est pas disponible, vous pouvez l'importer à l'aide de Importez la 
commande Importer fichier. 
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  Informations 

Le développement d'un assistant nécessite des connaissances concernant le modèle 
d'objet de zenon et le langage VBA. Ces rubriques ne sont pas couvertes dans ce 
didacticiel. 

 

 

 

 

 

Créez la surface affichée ci-dessus. Ensuite, basculez vers le module de codage du formulaire UserForm, 
puis faites défiler le fichier jusqu'à la fin. C'est là que vous trouverez les méthodes suivantes. 

 

 Public Function GetWizardName () As String 
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Renvoie le nom unique de l'assistant. Modifiez le contenu en Assistant de création de 
variables. 

 Public Function GetWizardInfo () As String 

Renvoie une brève description dans la sélection d'assistants. Modifiez le contenu en Assistant 
de création de variables pour un driver sélectionné. 

 Public Function GetWizardCategory () As String 

Renvoie la catégorie de l'assistant. Dans la sélection d'assistants, les assistants sont affichés sous 
forme d'arborescence des catégories. Modifiez le contenu en Variables. 

 Public Function IsZenOnWizard () As Boolean 

Affichage de l'assistant dans la sélection d'assistants. Si cette méthode renvoie la valeur False, 
l'assistant n'est pas affiché, par exemple parce qu'il n'est pas encore terminé. Modifiez le type de 
retour en True. 

  

Ces méthodes fournissent les informations concernant l'assistant demandées par le système de 
contrôle. Gardez à l'esprit que l'assistant est uniquement affiché dans la sélection d'assistants si la 
méthode IsZenOnWizard renvoie True. 

  

Basculez vers l'événement Initialize du formulaire UserForm, puis modifiez le contenu de la table de 
chaînes m_strCaption. Dans la mesure où cet assistant ne comporte que deux étapes, il est possible de 
supprimer les autres attributions. 

  

Ajoutez les définitions suivantes à la partie supérieure du module de code : 

Private m_obDriver As Driver  

Private m_obVarType As VarType  

Private m_nChannelType As Integer 

  

Créez une méthode d'initialisation de la zone de liste modifiable des drivers. Cette routine a pour 
objectif d'afficher tous les drivers chargés du projet actuel dans une zone de liste modifiable. 

cbDriver.Clear  

Dim nIndex As Long  

For nIndex = 0 To MyWorkspace.ActiveDocument.Drivers.Count - 1  

   Dim obDriver As Driver  

   Set obDriver = MyWorkspace.ActiveDocument.Drivers.Item(nIndex)  

   If (Not obDriver Is Nothing) Then  

      cbDriver.AddItem  

      obDriver.Name  

   End If  

Next nIndex  
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If (cbDriver.ListCount > 0) Then  

   cbDriver.ListIndex = 0  

End If 

  

En outre, une autre routine doit être définie pour afficher, dans une zone de liste modifiable, tous les 
types de variables définis dans le projet. 

If (Not m_obDriver Is Nothing) Then  

cbVarType.Clear  

Dim nIndex As Long , nSelect As Integer  

For nIndex = 0 To MyWorkspace.ActiveDocument.VarTypes.Count - 1  

Dim obVarType As VarType  

Set obVarType = MyWorkspace.ActiveDocument.VarTypes.Item(nIndex)  

If ( Not obVarType Is Nothing And obVarType.IsSimple = True) Then  

cbVarType.AddItem  

obVarType.Name  

If (obVarType.Name = INT) Then  

   nSelect = nIndex  

End If  

End If  

Next nIndex  

cbVarType.ListIndex = nSelect  

End If 

  

Lors de l'ouverture de l'assistant, toutes les variables existantes sont contrôlées, afin d'identifier un 
offset de départ libre pour la création des nouvelles variables. Pour cela, la méthode suivante est 
appliquée. 

Private Function FindHighestOffsetVar() As Long  

On Error GoTo Error  

Dim nIndex As Long, nOffset As Long  

For nIndex = 0 To MyWorkspace.ActiveDocument.Variables.Count - 1 

Dim obVar As Variable  

   Set obVar = MyWorkspace.ActiveDocument.Variables.Item(nIndex)  

   If ( Not obVar Is Nothing) Then  

   If (obVar.Offset > nOffset) Then  

         nOffset = obVar.Offset  

      End If  

   End If  

Next nIndex  

FindHighestOffsetVar = nOffset  

Exit Function  

Error : MsgBox  

Error occurs: + Err.Description + Source + Err.Source  

End Function 
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Basculez vers l'événement Initialize du formulaire UserForm, puis ajoutez les lignes suivantes à cette 
méthode : 

txtStart.Value = CStr(FindHighestOffsetVar + 1) 

InitializeDriver 

  

L'attribution à txtStart définit l'offset de départ pour la création des variables. La méthode 
InitializeDriver renseigne la zone de liste modifiable avec les drivers existants. 

Créez un événement Change pour la zone de liste modifiable de drivers et ajoutez-y le code suivant Une 
fois le driver sélectionné, les types de variables sont obtenus. L'objet de driver sélectionné est stocké 
dans la variable m_obDriver pour être utilisé ultérieurement. 

Private Sub cbDriver_Change()  

cmdNext.Enabled = True  

Set m_obDriver = MyWorkspace.ActiveDocument.Drivers.Item(cbDriver.Value)  

If ( Not m_obDriver Is Nothing) Then  

   InitializeVarType  

End If 

End Sub 

  

Créez un événement Change pour la zone de liste modifiable de variables et ajoutez-y le code suivant Le 
type de variable sélectionné est stocké dans la variable m_obVarType pour être utilisé ultérieurement. 

Private Sub cbVarType_Change()  

Set m_obVarType = MyWorkspace.ActiveDocument.VarTypes.Item(cbVarType.Value)  

End Sub 

  

Il ne reste maintenant plus qu'à créer la routine d'événement de création des variables avec les 
paramètres définis. Pour cela, il est nécessaire de cliquer sur le bouton Terminer. 

Private Sub cmdFinish_Click()  

On Error GoTo Error  

If (cbVarType.ListIndex = -1) Then  

MsgBox 'Please select a variable type'  

cbVarType.SetFocus  

Exit Sub  

End If  

If (txtStart.Value = Or txtCount.Value = Or txtStep.Value = ) Then  

MsgBox 'Please enter Start-Offset', 'count of creating variables and the step'  

txtStart.SetFocus  

End If  

If (m_obVarType Is Nothing) Then  

MsgBox 'Variable type + cbVarType.Name + doesnt exist!'  
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Exit Sub  

End If  

Dim nPrvMousePtr As Integer  

nPrvMousePtr = MousePointer  

MousePointer = fmMousePointerHourGlass  

DoEvents  

Dim strName As String  

Dim nIndex As Long , nVarIndex As Integer  

Dim nStartOff As Long , nStep As Integer  

nVarIndex = 1  

nStartOff = CLng (txtStart.Value)  

nStep = CLng (txtStep.Value)  

For nIndex = 0 To CLng (txtCount.Value - 1)  

Dim obVar As Variable  

strName = txtName.Value + _ + CStr (nIndex + 1)  

'*** Guaranteeing uniqueness of the variable name  

Dim bResult As Boolean   

bResult = False  

Do  

Set obVar = MyWorkspace.ActiveDocument.Variables.Item(strName)  

If (obVar Is Nothing) Then  

bResult = True  

Else  

nVarIndex = nVarIndex + 1  

strName = txtName.Value + _ + CStr (nVarIndex)  

End If  

Loop While   

bResult = False  

'*** Create variable  

Set obVar = MyWorkspace.ActiveDocument.Variables.CreateVar (strName, m_obDriver, 

tpSPSMerker, m_obVarType)  

If ( Not obVar Is Nothing) Then  

obVar.Offset = nStartOff  

nStartOff = nStartOff + nStep  

End If  

Next nIndex  

MousePointer = nPrvMousePtr  

Unload Me  

Exit Sub  

Error :  

MousePointer = nPrvMousePtr  

MsgBox Error occurs: + Err.Description + Source + Err.Source  

End Sub 

  

À la fin de l'assistant, la validité des paramètres définis est contrôlée. Si ce n'est pas le cas, un message 
est affiché et l'utilisateur est invité à corriger les entrées concernées. 
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Si les paramètres définis sont valides, les variables sont créées. Les variables reçoivent un nom et un 
indice. Si une variable portant le même nom existe déjà dans le projet, l'indice disponible suivant est 
utilisé. Dans notre exemple de code, une variable contenant le marqueur d'automate associé au type de 
canal est créée. À chaque cycle, l'offset de la variable augmente. 
 

4.6.5 Mise à jour des assistants 

Pour mettre à jour les assistants : 

1. In the Extras menu, select the Update Editor Add-Ins entry. 

Une boîte de dialogue permettant de mettre à jour les assistants disponibles s'affiche. 

2. Sélectionnez les assistants souhaités. 

3. Démarrez la mise à jour en cliquant sur Démarrer la mise à jour. 

Si un assistant ou une classe existe déjà dans l'espace de travail, un message d'avertissement est affiché. 

Attention 

Les assistants existants sont remplacés durant la mise à jour. Les modifications 
individuelles apportées à un assistant sont perdues. 

 
 

4.7 Foire aux questions 

Ce chapitre fournit des réponses à des questions fréquentes. Vous trouverez d'autres solutions en ligne, 
dans le forum des utilisateurs (http://www.copadata.com/forums/) de COPA-DATA. 
 

4.7.1 Pourquoi le bouton reste enfoncé ? 

Si Une marco est liée à l'événement LeftClickUp sur un bouton, alors à la fin de la macro il faut exécuter 
le LeftClickUp. 

Public Sub LeftClickUp_Schalter(obElem As Element)  

frmSchalter.Show 

obElem.LeftClickUp  

End Sub 
 

http://www.copadata.com/forums/
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4.7.2 La macro n'est pas exécutée avec le premier clic 

La solution correspond à la réponse fournie à la question : Pourquoi le bouton reste-t-il enfoncé ? (à la 
page 70) : 

Si Une marco est liée à l'événement LeftClickUp sur un bouton, alors à la fin de la macro il faut exécuter 
le LeftClickUp. 

Public Sub LeftClickUp_Schalter(obElem As Element)  

frmSchalter.Show 

obElem.LeftClickUp  
End Sub 
 

4.7.3 Les macros ne marchent plus dans le runtime ? 

Cela peut arriver si l'éditeur VBA est ouvert en runtime et que le Stop/Start est sélectionné pour arrêter 
/ démarrer VBA Dans ce cas, les objets (OnlineVariables, ScreenObjects, etc.) deviennent non valides, 
car ils perdent leur lien dans le cas d'une nouvelle initialisation. 
 

4.7.4 Windows CE et VBA 

Dans Editor, VBA peut être utilisé pour les assistants. Il ne peut pas être utilisé dans le Runtime. Pour 
des informations détaillées concernant l'éditeur, reportez-vous au chapitre Comment faire un projet CE. 
 

4.8 Exemples 

Vous trouverez ici quelques exemples de code VBA : 
 

4.8.1 Initialisation de MouseEvents et du contrôle ActiveX 

Option Explicit 

 

Public Sub Init_ActiveX(obElem As Element) 

 'Initialisation d'ActiveX... 

thisProject.Init_MSChart_AX obElem 

End Sub 
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Public Sub LeftClickUp_Sample1(obElem As Element) 

'Initialisation du formulaire Userform... 

frmSample1.InitForm obElem 

'Affichage du formulaire Userform 

frmSample1.Show 

End Sub 

 

Public Sub LeftClickUp_Sample2(obElem As Element) 

'Initialisation du formulaire Userform... 

frmSample2.InitForm obElem 

 'Affichage du formulaire Userform 

frmSample2.Show 

End Sub 

 

Public Sub LeftClickUp_Sample3(obElem As Element) 

'Initialisation du formulaire Userform... 

frmSample3.InitForm obElem 

 'Affichage du formulaire Userform 

frmSample3.Show 

End Sub 

 

Public Sub LeftClickUp_Sample4(obElem As Element) 

Dim NewForm As New frmSample4 

 'Initialisation du nouveau formulaire Userform... 

NewForm.InitForm obElem 

'Affichage du nouveau formulaire Userform 

NewForm.Show (0) 

End Sub 
 

4.8.2 Afficher les informations d'une variable 

Afficher le nom de la variable correspondant à l'élément sur lequel vous avez cliqué : 

 
Option Explicit 
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Dim obVar As Variable 

 

'Procédure publique d'initialisation d'objets définie par l'utilisateur 

 

Public Sub InitForm(obElem As Element) 

'définit l'objet variable sous forme de variable liée de l'élément 

Set obVar = obElem.ItemVariable(0) 

 'écrit la variable dans le champ de texte 

txtVarName.Text = obVar.Name 

End Sub 

 

Private Sub cmdExit_Click() 

 'ferme le formulaire Userform 

Unload Me 

End Sub 
 

4.8.3 Lire et écrire des valeurs de variable 

Lire la valeur de la variable et la réécrire : 

 
Option Explicit 

 

Dim obVar As Variable 

 

'Procédure publique d'initialisation d'objets définie par l'utilisateur 

 

Public Sub InitForm(obElem As Element) 

'définit l'objet variable sous forme de variable liée de l'élément 

Set obVar = obElem.ItemVariable(0) 

'écrit la variable dans le champ de texte 

txtVarName.Text = obVar.Name 

End Sub 

 

Private Sub cmdExit_Click() 
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'ferme le formulaire Userform 

 Unload Me 

End Sub 

 

Private Sub cmdRead_Click() 

'Lire la valeur de la variable et l'écrire dans le champ de texte : 

txtValue.Text = obVar.Value 

End Sub 

 

Private Sub cmdWrite_Click() 

'écrire le texte sous forme de valeur dans la variable 

obVar.Value = txtValue.Text 

'ou changer le texte en valeur avant l'écriture... 

 'obVar.Value = Val(txtValue.Text) 

End Sub 
 

4.8.4 Lire et écrire des variables et déployer les variables en ligne 

Lire les informations de la variable, écrire les valeurs et déployer les variables en ligne : 

 
Option Explicit 

 

Dim obVar As Variable 

Dim WithEvents zOnlineVariable As OnlineVariable 

 

'Procédure publique d'initialisation d'objets définie par l'utilisateur 

 

Public Sub InitForm(obElem As Element) 

'définit l'objet variable sous forme de variable liée de l'élément 

 Set obVar = obElem.ItemVariable(0) 

'écrit la variable dans le champ de texte 

txtVarName.Text = obVar.Name 



Liste de macros 

 

 

75 

 

 

'créer un conteneur OnlineVariable 

Set zOnlineVariable = thisProject.OnlineVariables.CreateOnlineVariables("OLV") 

'ajouter les variables au conteneur (selon le nom de la variable) 

zOnlineVariable.Add obVar.Name 

End Sub 

 

Private Sub cmdExit_Click() 

'ferme le formulaire Userform 

Unload Me 

End Sub 

 

Private Sub cmdRead_Click() 

'Lire la valeur de la variable et l'écrire dans le champ de texte : 

txtValue.Text = obVar.Value 

End Sub 

 

Private Sub cmdWrite_Click() 

'écrire le texte sous forme de valeur dans la variable 

obVar.Value = txtValue.Text 

'ou changer le texte en valeur avant l'écriture... 

 'obVar.Value = Val(txtValue.Text) 

End Sub 

 

Private Sub cmdOLV_Start_Click() 

'démarrer la variable OnlineVariable - Define 

 'l'événement VariableChange sera exécuté 

zOnlineVariable.Define 

End Sub 

 

Private Sub cmdOLV_Start_Click() 

'arrêter la variable OnlineVariable - UnDefine 

 'l'événement VariableChange sera arrêté 

zOnlineVariable.Undefine 

End Sub 

 

Private Sub zOnlineVariable_VariableChange(ByVal obVar As IVariable) 

'écrire la valeur réelle dans le champ de texte 

txtOLV.Text = obVar.Value 

End Sub 
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Private Sub UserForm_Terminate() 

'l'événement VariableChange sera arrêté s'il est en cours d'exécution 

zOnlineVariable.Undefine 

'supprimer le conteneur OnlineVariable 

thisProject.OnlineVariables.DeleteOnlineVariables ("OLV") 

End Sub 
 

4.8.5 Utiliser une boîte de dialogue plusieurs fois 

Les formulaires Userform peuvent être utilisés à plusieurs reprises. 

 
Option Explicit 

Dim obVar As Variable 

Dim WithEvents zOnlineVariable As OnlineVariable 

Dim strOLVName As String 

 

Public Sub InitForm(obElem As Element) 

'définit l'objet variable sous forme de variable liée de l'élément 

Set obVar = obElem.ItemVariable(0) 

'écrit la variable dans le champ de texte 

txtVarName.Text = obVar.Name 

'créer le nom du conteneur en ligne 

strOLVName = "OLV_" & obElem.Name 

'obtenir le conteneur en ligne existant 

Set zOnlineVariable = thisProject.OnlineVariables.Item(strOLVName) 

'vérifier si le conteneur en ligne existe 

If zOnlineVariable Is Nothing Then 

'créer un conteneur OnlineVariable 

Set zOnlineVariable = thisProject.OnlineVariables.CreateOnlineVariables(strOLVName) 

'ajouter les variables au conteneur (selon le nom de la variable) 

zOnlineVariable.Add obVar.Name 
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 End If 

End Sub 

 

Private Sub cmdExit_Click() 

Unload Me  'close Userform 

End Sub 

 

Private Sub cmdRead_Click() 

'Lire la valeur de la variable et l'écrire dans le champ de texte : 

txtValue.Text = obVar.Value 

End Sub 

 

 

Private Sub cmdWrite_Click() 

'écrire le texte sous forme de valeur dans la variable 

obVar.Value = txtValue.Text 

'ou changer le texte en valeur avant l'écriture... 

 'obVar.Value = Val(txtValue.Text) 

End Sub 

 

Private Sub cmdOLV_Start_Click() 

'l'événement VariableChange sera exécuté 

zOnlineVariable.Define 

End Sub 

 

Private Sub cmdOLV_Start_Click() 

'l'événement VariableChange sera arrêté 

zOnlineVariable.Undefine 

End Sub 

 

Private Sub zOnlineVariable_VariableChange(ByVal obVar As IVariable) 

'écrire la valeur réelle dans le champ de texte 

txtOLV.Text = obVar.Value 

End Sub 

 

Private Sub UserForm_Terminate() 

'l'événement VariableChange sera arrêté s'il est en cours d'exécution 

zOnlineVariable.Undefine 

'supprimer le conteneur OnlineVariable 
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thisProject.OnlineVariables.DeleteOnlineVariables (strOLVName) 

End Sub 

 
 

4.8.6 Alarme – Evénements et gestion des contrôles ActiveX 

Option Explicit 

 

Dim WithEvents obChart As MSChart 

Dim WithEvents zOLV As OnlineVariable 

Dim WithEvents zAlarm As Alarm 

 

'la procédure est exécutée au démarrage du Runtime zenon 

 

Private Sub Project_Active() 

'initialiser l'objet alarme pour les événements 

Set zAlarm = thisProject.Alarm 

End Sub 

 

'la procédure est exécutée lorsqu'une alarme est activée 

Private Sub zAlarm_AlarmComes(ByVal obItem As IAlarmItem) 

 Dim strInfo As String 

'écrire les informations spécifiques concernant l'alarme dans une variable StringVariable 

strInfo = obItem.Text & " - " & obItem.Name 

thisProject.Variables.Item("Var_Comes").Value = strInfo 

End Sub 

 

'la procédure est exécutée lorsqu'une alarme est désactivée 

Private Sub zAlarm_AlarmGoes(ByVal obItem As IAlarmItem) 

 Dim strInfo As String 

'écrire les informations spécifiques concernant l'alarme dans une variable StringVariable 

strInfo = obItem.Text & " - " & obItem.Name 

thisProject.Variables.Item("Var_Goes").Value = strInfo 

End Sub 

 

'la procédure est exécutée lorsqu'une alarme a été acquittée par un utilisateur 

Private Sub zAlarm_AlarmAcknowledged(ByVal obItem As IAlarmItem) 
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 Dim strInfo As String 

'écrire les informations spécifiques concernant l'alarme dans une variable StringVariable 

strInfo = obItem.Text & " - " & obItem.Name 

thisProject.Variables.Item("Var_Acknowledged").Value = strInfo 

End Sub 

 

'la procédure est exécutée lors de l'arrêt du Runtime zenon 

Private Sub Project_Inactive() 

'libérer l'objet alarme 

Set zAlarm = Nothing 

'supprimer la varable OnlineVariable pour actualiser la fonction Chart... 

thisProject.OnlineVariables.DeleteOnlineVariables "CHART" 

End Sub 

 

'procédure d'initialisation du contrôle ActiveX MSChart... 

Public Sub Init_MSChart_AX(YourAX As Element) 

Set obChart = YourAX.AktiveX 

obChart.RowCount = 3 

obChart.ColumnCount = 1 

Set zOLV = thisProject.OnlineVariables.Item("CHART") 

'est-ce que la variable OnlineVariable actuelle existe ? 

If zOLV Is Nothing Then 

'si ce n'est pas le cas, elle doit être créée... 

Set zOLV = thisProject.OnlineVariables.CreateOnlineVariables("CHART") 

zOLV.Add "Internal_UINT_001" 

zOLV.Add "Internal_UINT_002" 

zOLV.Add "Internal_UINT_003" 

 End If 

zOLV.Undefine 'en cas d'arrêt, l'actualisation est impossible 

'START - début de la surveillance des variables... 

zOLV.Define 

End Sub 

 

'événement en cas de modification de la variable - actualisation du diagramme.... 

Private Sub zOLV_VariableChange(ByVal obVar As IVariable) 

'configuration des valeurs à afficher dans le contrôle du diagramme 

Select Case obVar.Name 

Case "Internal_UINT_001" 

obChart.Row = 1 
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obChart.RowLabel = "Var1" 

obChart.Data = obVar.Value 

Case "Internal_UINT_001" 

obChart.Row = 2 

obChart.RowLabel = "Var2" 

obChart.Data = obVar.Value 

Case "Internal_UINT_003" 

obChart.Row = 3 

obChart.RowLabel = "Var3" 

obChart.Data = obVar.Value 

 End Select 

End Sub 

 

'événement du contrôle ActiveX Chart... 

Private Sub obChart_DblClick() 

  MsgBox "Vous avez double-cliqué sur le contrôle ActiveX !" 

End Sub 

 
 

4.8.7 Accès aux alarmes 

 

DESCRIPTION :  

Dans la boîte de dialogue (form) frmAlarm, une alarme en mémoire peut être sélectionnée dans un 
combobox. Après la sélection, toutes les données de l'alarme sont écrites dans les champs texte 
ci-dessous (groupe, classe, variable, ...). 

On utilise une macro indépendante des événements pour afficher le frmAlarm, car on ne la lie pas à un 
élément. 
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Sub Alarm ()  

frmAlarm.Show  

End Sub 

'La macro est exécutée avec la fonction "Exécuter marco". 

'A l'ouverture, la boîte de dialogue (form) est initialisée et donc la procédure suivante 

est exécutée. Cette procédure s'occupe d'écrire toutes les alarmes en mémoire dans le 

combobox (liste de choix) dans la boîte de dialogue (form).  

  

Private Sub UserForm _ Initialize ()  

 

'fill combobox with all AlarmItems  

Dim i As Integer  

Dim obAlarmItems As AlarmItems  

Dim obAlarm As Alarm  

 

Set obAlarm = thisProject.Alarm  

Set obAlarmItems = obAlarm.AlarmItems (*)  

 

If obAlarmItems.Count = 0 Then  

MsgBox (# Alarms = 0 )  

Exit Sub  

End If  

 

For i = 0 To obAlarmItems.Count - 1  

cmbAlarmItems.AddItem obAlarmItems.Item ( i ). Name  

Next i  

 

txtAktiv.Text = obAlarm.Aktiv  

cmbAlarmItems.Text = cmbAlarmItems.List ( 0 )  

End Sub 

 

'Lorsqu'une alarme est sélectionnée dans la zone de liste, l'événement Modifier de la zone 

de liste réagit. 

Private Sub cmbAlarmItems _ Change ()  

 

'Insérer les propriétés actuelles de l'élément AlarmItem dans des zones de texte  

Dim obAlarmItems As AlarmItems  

Dim obAlar As Alarm  

 

Set obAlarm = thisProject.Alarm  

Set obAlarmItems = obAlarm.AlarmItems (*)  

txtComputer.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Computer  

txtCountreactivated.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Countreactivated  

txtName.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ). Name  

txtProjectname.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Projectname  

txtStatus.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Status  
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txtStatusreactivated.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex 

).Statusreactivated  

txtTagname.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Tagname  

txtTimecomes.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Timecomes  

txtTimegoes.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Timegoes  

txtTimequitted.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Timequitted  

txtTimereactivated.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Timereactivated  

txtUser.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).User  

txtUsertext.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Usertext  

txtValue.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).Value  

tbGroup.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).AlarmGroup  

tbClass.Text = obAlarmItems.Item ( cmbAlarmItems.ListIndex ).AlarmClass  

End Sub 
 

4.8.8 Définition d'un interrupteur (utilisation de variables de procédé) 

 

Dans cet exemple, on dessine une pompe qui est constitué d'un cercle et d'un triangle. Définissez le 
triangle en tant que symbole. Par dessus, dessinez une combinaison multiple et liez-la à trois variables 
booléennes. 

De plus, définissez la couleur que le triangle doit prendre selon les valeurs de ces variables. 

D'abord, nous combinons la combinaison multiple avec une macro qui ouvre un 'form' VBA de nom 
frmSwitch. 

Dans la boîte de dialogue (le 'form' VBA), nous serons capable de change les valeurs des trois booléens. 

 

  Informations 

Seule une des trois variables peut avoir la valeur 1 (c'est à dire si une des variables est 
mise à 1, les deux autres sont mises à 0). 
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Pour pouvoir utiliser cette macro plusieurs fois dans le projet avec différentes variable, les variables liées 
à la combinaison multiple peuvent contenir dans leur nom l'état de la pompe qu'elle contrôle. 

Par exemple :  
Variable_Auto  
Variable_Hand  
Variable_Revi 

 

  Informations 

Les suffixes _Auto, _Hand et _Revi sont définis de façon fixe dans le code source de 
l'exemple. 

 

Avec les suffixes de 5 caractères des noms de variables, on définit quelle variable est mise à 1 ou à 0 en 
cliquand sur un bouton 'toggle' (bascule). 

Dans la macro LeftClickUp_Switch un sous-programme FindVariable est appelé dans le 'form' frmSwitch 
qui récupère l'élément qui a été sélectionné dans obElem. 

Public Sub LeftClickUp_Schalter (obElem As Element)  

frmSchalter.FindVariable obElem  

position (pixel en points = (pixel * 0,75))  

frmSchalter.Top = obElem.Bottom * 0.75  

frmSchalter.Left = obElem.Left * 0.75  

frmSchalter.Show  

obElem.LeftClickUp  

End Sub 

Déclaration des variables globales : 

Dim cmdLast As ToggleButton  

Dim strHand As String  

Dim strAuto As String  

Dim strRevi As String 

Dans le sous-programme FindVariable, toutes les variables liées à l'élément passé sont 

contrôlées. 

Selon le suffixe (_Auto, _Hand or _Revi), les noms des variables sont assignés aux variables string 
déclarées ci-dessus. 

De plus, les états des variables sont déterminés et dépendent de la valeur (1 ou 0) du bouton 
d'activation correspondant (enfoncé ou pas). 

Lors de l'ouverture de la boîte de dialogue frmSwitch, le nom du bouton 'toggle' couramment enfoncé 
est écrit dans une variable string. Dans le cas où l'utilisateur décide d'annuler cette action, les valeurs 
originales sont restaurées. 
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Public Sub FindVariable (obElem As Element)  

Dim i As Integer  

Dim obVariable As Variable  

 

For i = 0 To obElem . CountVariable - 1  

Select Case Right $( obElem. ItemVariable ( i ). Name , 5 )  

Case _ Auto  

strAuto = obElem . ItemVariable ( i ). Name  

 

Case _ Hand  

strHand = obElem . ItemVariable ( i ). Name  

 

Case _ Revi  

strRevi = obElem . ItemVariable ( i ). Name  

End Select  

Next i  

 

Set obVariable = thisProject . Variables . Item ( strHand )  

If obVariable . Value = 1 Then  

tbHand . Value = True  

Set cmdLast = tbHand  

End If  

 

Set obVariable = thisProject . Variables . Item ( strAuto )  

If obVariable . Value = 1 Then  

tbAuto . Value = True  

Set cmdLast = tbAuto  

End If  

 

Set obVariable = thisProject . Variables . Item ( strRevi )  

If obVariable . Value = 1 Then  

tbRev . Value = True  

Set cmdLast = tbRev  

End If  

 

If tbHand . Value = False And tbAuto . Value = False And tbRev . Value = False Then  

tbOff . Value = True  

Set cmdLast = tbOff  

End If  

End Sub 

La fonction créée automatiquement VarExists vérifie seulement si les variables liées existent réellement. 
Si ce n'est pas le cas, un message d'erreur est affiché. La variable n'existe pas. 

Function VarExists ()  

 

Dim obVariable As Variable  

Set obVariable = thisProject . Variables . Item (strHand)  
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If obVariable Is Nothing Then   

MsgBox (Variable doesnt extist)  

VarExitsts = False  

Exit Function  

End If  

 

Set obVariable = thisProject . Variables . Item (strAuto)  

If obVariable Is Nothing Then  

MsgBox (La variable n'existe pas)  

VarExitsts = False  

Exit Function  

End If  

 

Set obVariable = thisProject . Variables . Item (strRev)  

If obVariable Is Nothing Then   

MsgBox ( Variable doesnt extist )  

VarExitsts = False  

Exit Function  

End If   

 

VarExists = True  

End Function 

Si l'utilisateur clique sur Annuler (Cancel), la modification de valeur est annulée et la valeur originale est 
restaurée. 

Private Sub cmdExit _ Click ()  

cmdLast.Value = True  

Unload Me  

End Sub  

 

Private Sub cmdOk _ Click ()  

Unload Me  

End Sub 

Si un bouton 'toggle' est cliqué, aucun autre bouton 'toggle' ne peut être sélectionné. 

Private Sub tbAuto_Change ()  

If tbAuto . Value = False And tbHand.Value = False And tbRev . Value = False Then  

tbOff . Value = True  

End Sub 

Dans l'événement click de chaque bouton 'toggle', on vérifie si il est enfoncé et si la variable existe. Si les 
deux conditions sont vraies, alors les valeurs sont envoyées vers les variables liées. 
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5. VSTA 

With Visual Studio Tools for Applications (VSTA), the functionality of zenon Runtime and the Editor 
can be enhanced independently by means of .NET programming. 

  Informations 

Note that in VSTA, only assemblies (DLLs) up to a maximum of .NET framework version 
3.5 can be included. 

VSTA is also, with a few restrictions, available on the zenon Web Client. 

VSTA comporte des environnements de développement distincts pour l'Espace de travail et le projet. 
Vous ne pouvez en utiliser qu'un à la fois. Au démarrage, tous les autres environnements de 
développement VSTA ouverts seront fermés. 

Pour ouvrir l'Éditeur VSTA pour l'espace de travail : 

1. Appuyez sur les touches Alt+F10. 

Le code correspondant à l'espace de travail et à tous les projets chargés est affiché 

Pour ouvrir l'Éditeur VSTA pour le projet actuellement chargé : 

1. Accédez au nœud Script. 

2. Expand the view of this node by clicking on [+]. 
The view of the node is expanded. 

3. Cliquez avec le bouton droit sur VSTA 

In the context menu, select Open VSTA editor with ProjectAddin. 
The editor is opened for the currently-loaded project. 

  Informations 

Si des macros VBA sont modifiées dans l'Éditeur, 

 Les fichiers de Runtime sont compilés et transférés vers le Runtime 

 Le Runtime est actualisé 

 Les éléments VSTA sont également actualisés, même si aucune modification n'a été 
effectuée dans VSTA 

  
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5.1 Notions fondamentales 

VSTA est un environnement de développement Microsoft fondé sur la technologie .NET. Il est nécessaire 
de disposer d'une connaissance des principes de la programmation orientée objet, de .NET et de 
C#/Visual Basic.NET pour le comprendre. 

Attention 

Note in Runtime: Referenced dlls cannot be replaced if they are loaded. Runtime must be 
ended in order for a reference file to be updated. 

 
 

5.1.1 Configuration de l'environnement VSTA 

La prise en charge de VSTA est déjà activée par défaut dans zenon. Lors de la désactivation de la prise en 
charge de VBA, l'environnement VSTA n'est également plus disponible. 

The VSTA environment can be activated or deactivated manually with the following entry in zenon6.ini: 

Activer VSTA Désactiver VSTA 

[VSTA] 

ON=1 

[VSTA] 

ON=0 

La prise en charge de VBA est activée ou désactivée comme suit : 

Activer VBA Désactiver VBA 

[VBA] 

EIN=1 

[VBA] 

EIN=0 

L'environnement de développement pour VSTA dans zenon est alors disponible. 

  Informations 

VSTA autorise le développement de projets dans les langages de programmation C# et 
Visual Basic .NET. C# est considéré comme le langage standard des projets VSTA dans 
l'Éditeur Le langage peut être changé en Visual Basic.NET avec l'entrée suivante : 

[VSTA] 

CSHARP=0 
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5.1.2 Accès au modèle d'objet zenon 

Le modèle d'objet zenon utilisé dans VBA est également accessible dans VSTA. Le modèle d'objet offre 
des fonctionnalités identiques dans les deux environnements de développement. 

Attention 

Certaines modifications apportées au modèle d'objet ont été réalisées en raison des 
limites inhérentes à la dénomination d'objets VSTA. Vous les trouverez dans le tableau 
ci-dessous. 

 

Ancienne propriété Nouvelle propriété 

IDriver.Name IDriver.Identification 

IDriver.Driver IDriver.Name 

Ancien événement Nouvel événement 

IApplication.Close IApplication.OnClose 

IZenWorkspace.Startup IZenWorkspace.OnStartup 

IZenWorkspace.Exit IZenWorkspace.OnExit 

L'accès dans VSTA est autorisé via l'objet this, qui remplace l'objet MyWorkspace dans VBA. Les 
méthodes et objets suivants sont identiques. Dans la méthode suivante, un gabarit portant le nom 
TemplateName est créée dans zenon. 

public void Macro1() 

{ 

this.ActiveDocument.Templates().Create("TemplateName", true); 

} 

  Informations 

Contrairement à VBA, l'utilisation des lettres majuscules et minuscules après les noms de 
fonctions est importante dans VSTA. 

 

Pour accéder aux méthodes dans zenon, vous devez enregistrer et compiler le projet en procédant 
comme suit : 

1. Cliquez sur Fichier -> Enregistrer MyWorkspace.cs pour enregistrer le projet. 

2. Cliquez sur Fichier -> Construire WorkspaceAddin pour compiler le projet. 

La méthode est ensuite disponible en tant que macro dans la barre d'outils Macro VBA de l'Éditeur 
zenon. Si la boîte de dialogue d'affectation des macros n'affiche pas toutes les macros de MyWorkspace, 
exécutez la fonction Recharger la liste des macros VBA depuis la barre d'outils. 
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  Informations 

Les macros VSTA comportant des paramètres, par exemple Public void 
MacroWithParam(string mString), ne sont pas prises en charge et ne sont pas 
disponibles dans la barre d'outils de macros. 

 
 

5.1.3 Fonctions dans zenon 

Pour VSTA, de fonctions ont été créées dans zenon. These are in the VSTA node. 

 

Parallèlement aux fonctions VBA existantes, des fonctions semblables ont été mises en œuvre pour 
VSTA : 
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Nom fonction Description 

Ouvrir l'éditeur VSTA Ouvre l'éditeur VSTA dans le Runtime. 

Exécuter macro VSTA Une macro VSTA peut être sélectionnée dans l'éditeur ; elle 
sera démarrée lors de l'exécution de la fonction dans le 
Runtime. 

  Les macros VSTA comportant des paramètres, par 
exemple Public void MacroWithParam(string mString), 
ne sont pas prises en charge. Elles ne sont pas non plus 
disponibles aux fins du développement dans l'Éditeur, ni au 
démarrage de la fonction dans le Runtime. 

Montrer la boîte de dialogue des 

macros VSTA 

Une boîte de dialogue est affichée dans le Runtime ; elle 
contient une liste des macros VSTA existantes, que vous pouvez 
sélectionner et exécuter à votre convenance. 

 
 

Exécuter macro VSTA 

Dialog for configuration of the Exécuter macro VSTA function. 
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Paramètre Description 

Macros existantes  

Liste des macros VSTA Lists all existing VSTA macro. 
Selection of a macro from the list by clicking on it. 

  A double click executes the selected macro. 

Aucun utilisateur sélectionné Annule la sélection et ferme la boîte de dialogue. 

OK Executes selected macro and closes the dialog. 

Annuler Annule la sélection et ferme la boîte de dialogue. 

Aide Ouvre l'aide en ligne. 

 
 

5.1.4 Débogage d'une macro complémentaire VSTA 

Il est possible de déboguer les macros complémentaires que vous avez créées dans l'éditeur VSTA. A 
cette fin, notez que les macros complémentaires du projet peuvent uniquement être déboguées dans le 
Runtime zenon, et que les macros complémentaires de l'espace de travail peuvent uniquement être 
déboguées dans l'Éditeur zenon. 

Pour démarrer une session de débogage, sélectionnez Debug -> Start Debugging (Débogage -> Démarrer le 

débogage). Vous pouvez insérer des points d'interruption de la même manière que dans l'éditeur VBA, en 
cliquant avec le bouton gauche dans la barre d'outils de points d'interruption grise, près de la marge 
gauche adjacente à la cellule correspondante. 

  Informations 

Lors du débogage de macros complémentaires du Runtime, tenez compte des aspects 
suivants : 

Les fichiers de Runtime modifiés dans zenon doivent être recréés avant le débogage. 

 
 

5.1.5 Events in VSTA 

Une macro complémentaire se termine lors de la compilation d'un code modifié et du démarrage ou de 
l'arrêt d'une session de débogage ; aussi, de nouveaux événements ont été mis en œuvre dans VSTA. Ils 
permettent par exemple d'évaluer et d'approuver la référence d'un objet, ainsi que d'enregistrer les 
données existantes. 
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Deux événements sont associés à chaque fin. Le premier événement démarre peu de temps avant la fin, 
et le deuxième démarre après le démarrage d'une nouvelle session d'une macro complémentaire. 

Événement Description 

OnPreVSTADebugStart est déclenchée peu de temps avant le démarrage d'une 
session de débogage. Lors du démarrage d'une session de 
débogage, une macro complémentaire active est 
supprimée ; les références doivent être approuvées et les 
données existantes doivent être enregistrées, le cas 
échéant. 

OnVSTADebugStart est déclenchée peu de temps après le démarrage d'une 
session de débogage. 

OnPreVSTADebugStop est déclenchée peu de temps avant l'arrêt d'une session 
de débogage. Lors de l'arrêt d'une session de débogage, 
une macro complémentaire active est supprimée ; les 
références doivent être approuvées et les données 
existantes doivent être enregistrées, le cas échéant. 

OnVSTADebugStopped est déclenchée peu de temps après l'arrêt d'une session 
de débogage. 

OnPreVSTAUpdate est déclenchée avant la suppression de la macro 
complémentaire, si une nouvelle version de la macro 
complémentaire a été créée avec succès. 

OnPostVSTAUpdate est déclenchée lorsqu'une nouvelle version de la macro 
complémentaire est chargée. 

 
 

5.1.6 Créer une sauvegarde de projets VSTA 

Les projets VSTA dans le Runtime sont automatiquement enregistrés sous forme d'archive zip lors de la 
création du fichier Runtime, puis intégrés aux enregistrements de l'espace de travail. 

En revanche, les projets VSTA dans l'éditeur doivent être enregistrés manuellement.  
Les projets de l'Éditeur VSTA se trouvent dans le dossier 
C:/ProgramData/COPA-DATA/*version*/VSTAWorkspace/ . 
 

5.2 Créer un projet VSTA 

A l'instar de VBA, VSTA offre la possibilité de créer des projets pour l'éditeur et le Runtime. En principe, 
les projets dans l'éditeur sont mis en œuvre dans le langage de programmation C#. Dans le Runtime et 
Editor, C# et Visual Basic.NET sont tous deux disponibles. 
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  Informations 

Note that in VSTA, only assemblies (DLLs) up to a maximum of .NET framework version 
3.5 can be included. 

  Informations 

Un seul projet peut être affiché à la fois dans l'éditeur VSTA. En outre, une seule instance 
de l'éditeur VSTA peut être active. Lors du démarrage de l'éditeur VSTA, toute instance en 
cours d'exécution est fermée. 

 
 

5.2.1 Projets VSTA dans l'éditeur 

Lors de la création d'un projet pour l'Éditeur zenon, une macro complémentaire VSTA pour l'espace de 
travail est chargée. Pour modifier la macro complémentaire, vous devez ouvrir l'éditeur VSTA en 
cliquant sur Fichier - Ouvrir éditeur VSTA.... L'interface utilisateur de l'éditeur VSTA est identique à 
l'environnement de développement Visual Studio de Microsoft. 

  Informations 

Vous pouvez accéder à l'aide de l'éditeur VSTA en sélectionnant le menu Aide -> Contenu. 
Cette aide fournit un aperçu général des fonctions de l'éditeur, des fonctions de 
l'infrastructure .NET Framework et de la programmation en Visual Basic.NET et C#. 

La macro complémentaire VSTA est essentiellement constituée de la classe MyWorkspace. Vous pouvez 
maintenant étendre cette classe avec vos propres méthodes. Par défaut, la classe accepte les deux 
méthodes suivantes : 

Fonction Description 

MyWorkspace_Startup Exécutée automatiquement au démarrage de zenon, 
après la création d'une version et au démarrage d'une 
session de débogage. 

MyWorkspace_Shutdown Exécutée automatiquement au démarrage de zenon, 
après la création d'une version et au démarrage d'une 
session de débogage. 
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Attention 

Les noms de méthodes peuvent uniquement commencer par Macro (par exemple 
Macro1, MacroVSTA) ;  ils ne doivent pas contenir de paramètres et doivent être 
définis comme publics. En outre, les noms de classes et d'autres méthodes et 
événements créés par VSTA ne peuvent pas être modifiés. 

Pour accéder aux méthodes dans zenon, vous devez enregistrer et compiler le projet en procédant 
comme suit : 

1. Cliquez sur Fichier -> Enregistrer MyWorkspace.cs pour enregistrer le projet. 

2. Cliquez sur Fichier -> Construire WorkspaceAddin pour compiler le projet. 

La méthode est ensuite disponible en tant que macro dans la barre d'outils Macro VBA de l'Éditeur 
zenon. Si la boîte de dialogue d'affectation des macros n'affiche pas toutes les macros de MyWorkspace, 
exécutez la fonction Recharger la liste des macros VBA depuis la barre d'outils. 
 

5.2.2 Projets VSTA dans le Runtime 

Pour créer un projet VSTA pour le Runtime, l'environnement VSTA doit être démarré.  
Procédez comme suit : 

1. Ouvrez l’entrée Interface de programmation dans le Gestionnaire de projet. 

2. Ouvrez le menu contextuel VSTA. 

3. Cliquez sur Ouvrir éditeur VSTA... 

Remarque : A selection dialog is shown when it is opened for the first time. You select the 
programming language in this. 

Un projet est ensuite créé dans le langage de programmation de votre choix. 

  Informations 

The programming language cannot be subsequently changed. This dialog is therefore 
only shown when being opened for the first time. 

Dans ce projet, une classe appelée ThisProject  est créée par zenon ; elle accepte les deux méthodes 
suivantes : 

Fonction Description 

ThisProject_Startup Exécutée automatiquement au démarrage du Runtime. 

ThisProject_Shutdown Exécutée automatiquement à l'arrêt du Runtime. 

Vous pouvez maintenant étendre la classe avec vos propres méthodes. 
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Attention 

Les noms de méthodes peuvent uniquement commencer par Macro (par exemple 
Macro1, MacroVSTA) ;  ils ne doivent pas contenir de paramètres et doivent être 
définis comme publics. En outre, les noms de classes et d'autres méthodes et 
événements créés par VSTA ne peuvent pas être modifiés. 

Il est possible d'accéder à toutes les fonctionnalités du Runtime via le modèle d'objet zenon. Les 
fonctions spécifiques à l'éditeur ne peuvent pas être utilisées comme dans VBA. 

Le Runtime zenon démarre automatiquement au démarrage du programme de débogage. Vous 
trouverez d'autres informations au chapitre relatif audébogage d'une macro complémentaire VSTA (à la 
page 91). 

  Informations 

Vous pouvez accéder à l'aide de l'éditeur VSTA en sélectionnant le menu Aide -> Contenu. 
Cette aide fournit un aperçu général des fonctions de l'éditeur, des fonctions de 
l'infrastructure .NET Framework et de la programmation en Visual Basic.NET et C#. 

 
 

5.2.3 Développement d'assistants dans VSTA 

L'environnement VSTA, à l'image de VBA (à la page 62), offre la possibilité de développer vos propres 
assistants. 

Pour pouvoir accéder à un formulaire dans le modèle d'objet zenon, vous devez copier une référence à 
celui-ci dans le formulaire. Pour cela, créez une méthode dans la classe MyWorkspace . Dans l'exemple 
suivant, une instance de formulaire est créée avec le nom Wizard (Assistant) et la méthode 
ZenonInstance, avec une référence au modèle d'objet zenon invoquée en tant que paramètre. Pour 
afficher le formulaire Wizard, sélectionnez ShowDialog(). 

public void Macro1() 

{ 

Form1 Wizard = new Form1(); 

Wizard.ZenonInstance(this.Application); 

Wizard.ShowDialog(); 

} 

Une variable membre reconnaissant le modèle d'objet zenon doit être créée dans le code du formulaire. 

public zenOn.IApplication m_Zenon=null; 

Enfin, la méthode ZenonInstance est créée. Cette méthode insère la référence du modèle d'objet dans 
l'objet m_Zenon. 
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public void ZenonInstance(zenOn.IApplication app) 

{ 

m_Zenon = app; 

} 

Vous pouvez maintenant développer, dans le formulaire, vos propres classes et méthodes employant le 
modèle d'objet. Tous les objets, méthodes et attributs sont accessibles via l'objet m_Zenon. 
 

5.3 Exemples 

Ici, vous trouverez des exemples de l'utilisation de VSTA, dans le Runtime et dans l'éditeur. 
 

5.3.1 Création de variables dans l'Éditeur zenon 

Dans cet exemple, un fichier texte est ouvert et le contenu de ce fichier est utilisé pour créer les 
variables dans l'Éditeur zenon. Le fichier texte peut contenir autant de lignes que vous le souhaitez. 
Chaque ligne inclut le nom et le type de données d'une variable ; ces informations sont séparées par une 
virgule (exemple : Variable1,BOOL). 

La méthode Macro1 recherche d'abord le driver interne dans l'Éditeur zenon. L'utilisateur voit ensuite 
s'afficher une boîte de dialogue de sélection de fichier, dans laquelle il doit sélectionner le fichier texte. 
La méthode lit ensuite le fichier texte et crée les variables. La méthode GetDataType est ensuite requise 
pour déterminer et attribuer le type de données associé lors de la création des variables. 

C# code 

using System; 

using System.Windows.Forms; 

using System.IO; 

using zenOn; 

 

namespace WorkspaceAddin 

{ 

[System.AddIn.AddIn("MyWorkspace", Version = "1.0", Publisher = "", Description =

 "")] 

public partial class MyWorkspace 

{ 

private void MyWorkspace_Startup(object sender, EventArgs e) 

{ 

} 
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private void MyWorkspace_Shutdown(object sender, EventArgs e) 

{ 

} 

public IVarType GetDataType(string vType) 

{ 

//gets the corresponding vartypes for bool, int, real and strings 

IVarType retType; 

switch (vType) 

{ 

case "BOOL": 

retType = this.ActiveDocument.VarTypes().Item("BOOL"); 

break; 

case "INT": 

retType = this.ActiveDocument.VarTypes().Item("INT"); 

break; 

case "REAL": 

retType = this.ActiveDocument.VarTypes().Item("REAL"); 

break; 

case "STRING": 

retType = this.ActiveDocument.VarTypes().Item("STRING"); 

break; 

par défaut : 

retType = this.ActiveDocument.VarTypes().Item("INT"); 

break; 

} 

return retType; 

} 

 

//Reads a defined text file and creates corresponding variables on the zenon inte

rnal driver 

public void MacroCreateVariablesFromFile() 

{ 

 

//create objects that will take the internal driver and the variable type 

IDriver zenonInternDriver = null; 

//search for the Internal driver and throw exception if no driver was found 

try 

{ 
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for (int driverCount = 0; driverCount < this.ActiveDocument.Drivers().Count; driv

erCount++) 

{ 

if (this.ActiveDocument.Drivers().Item(driverCount).Name == "Intern") 

{ 

zenonInternDriver = this.ActiveDocument.Drivers().Item(driverCount); 

break; 

} 

} 

} 

catch (Exception driverEx) 

{ 

MessageBox.Show("Impossible de trouver le driver zenon 

'Intern'. Erreur : " + driverEx.Message); 

throw; 

} 

this.ActiveDocument.Variables().DoAutoSave(false); 

try 

{ 

OpenFileDialog varFileSelect = new OpenFileDialog(); 

String[] varLine = new String[2]; 

 

//afficher la boîte de dialogue de sélection de fichier 

if (varFileSelect.ShowDialog() == DialogResult.OK) 

{ 

string line = string.Empty; 

//ouvrir le nouveau lecteur de flux avec le fichier sélectionné 

StreamReader importReader = new StreamReader(varFileSelect.FileName, System.Text.

Encoding.Default); 

 

//acquérir les données ligne par ligne, scinder les lignes à chaque ',' et créer les 

variables 

while ((line = importReader.ReadLine()) != null) 

{ 

varLine = line.Split(new Char[] { ',' }); 

this.ActiveDocument.Variables().CreateVar(varLine[0], zenonInternDriver, tpKanalt

ypes.tpSystemVariable, GetDataType(varLine[1])); 

} 

importReader.Close(); 
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} 

} 

catch (Exception fileEx) 

{ 

MessageBox.Show("An error occurred while opening the file: " + fileEx.Message); 

throw; 

} 

this.ActiveDocument.Variables().DoAutoSave(true); 

} 

#region Code généré par VSTA 

private void InternalStartup() 

{ 

this.Startup += new System.EventHandler(MyWorkspace_Startup); 

this.Shutdown += new System.EventHandler(MyWorkspace_Shutdown); 

} 

#endregion 

} 

} 

 
 

5.3.2 Écriture des informations du projet dans la fenêtre de sortie zenon. 

Dans cet exemple, nous allons démontrer comment accéder à la fenêtre de sortie des éditeurs zenon à 
l'aide de VSTA. La méthode nommée Macro1 lit les synoptiques de procédé créés dans le projet à cette 
fin, identifie le gabarit concerné et tous les drivers disponibles, ainsi que leurs intitulés. 

C# code 

using System; 

 

namespace WorkspaceAddin 

{ 

[System.AddIn.AddIn("MyWorkspace", Version = "1.0", Publisher = "", Description =

 "")] 

public partial class MyWorkspace 

{ 

private void MyWorkspace_Startup(object sender, EventArgs e) 

{ 
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} 

 

private void MyWorkspace_Shutdown(object sender, EventArgs e) 

{ 

 

} 

 

public void MacroPrintDebugInformation() 

{ 

string picName = string.Empty; 

string corTemp = string.Empty; 

string driverName = string.Empty; 

string driverDescription = string.Empty; 

 

//imprimer la chaîne de démarrage dans la fenêtre de sortie 

 

this.Application.DebugPrint(" --------------START--------------", zenOn.tpDebugPr

intStyle.tpMsg); 

 

//parcourir tous les synoptiques et imprimer le nom et le modèle utilisé dans la fenêtre 

de sortie 

 

for (int i = 0; i < this.ActiveDocument.DynPictures().Count; i++) 

{ 

picName = this.ActiveDocument.DynPictures().Item(i).Name; 

corTemp = this.ActiveDocument.DynPictures().Item(i).get_DynProperties("Template")

.ToString(); 

this.Application.DebugPrint(" Picture '" + picName + "' uses Template '" + corTem

p + "'", zenOn.tpDebugPrintStyle.tpMsg); 

} 

 

//print separator string into output window 

 

this.Application.DebugPrint(" ------------------------------", zenOn.tpDebugPrint

Style.tpMsg); 

 

//parcourir tous les drivers et imprimer le nom et la description dans la fenêtre de 

sortie 
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for (int i = 0; i < this.ActiveDocument.Drivers().Count; i++) 

{ 

driverName = this.ActiveDocument.Drivers().Item(i).Name; 

driverDescription = this.ActiveDocument.Drivers().Item(i).Identification; 

this.Application.DebugPrint(" Driver '" + driverName + "' has description '" + dr

iverDescription + "'", zenOn.tpDebugPrintStyle.tpMsg); 

} 

//imprimer la chaîne de fin dans la fenêtre de sortie 

this.Application.DebugPrint(" ---------------END---------------", zenOn.tpDebugPr

intStyle.tpMsg); 

} 

 

#region Code généré par VSTA 

 

private void InternalStartup() 

{ 

this.Startup += new System.EventHandler(MyWorkspace_Startup); 

this.Shutdown += new System.EventHandler(MyWorkspace_Shutdown); 

} 

#endregion 

} 

} 

 
 

5.3.3 Acquisition des variables dans zenon par le biais d'expressions régulières 

Dans l'exemple suivant, les variables de zenon sont lues dans un projet de Runtime et enregistrées dans 
un fichier texte local. 

A l'aide d'expressions régulières, les variables sont uniquement lues si leurs noms commencent par 3 
chiffres suivis d'un tiret bas (par exemple, 001_var ou 234_xyz). L'utilisateur doit alors sélectionner un 
dossier. Un fichier texte comportant un nom défini en fonction de l'heure est créé dans ce dossier. Dans 
ce fichier, les noms, intitulés et valeur actuelle de doutes les variables concernées sont enregistrés, 
séparés par un point-virgule. 

  Informations 

Il est possible que des références manuelles doivent être ajoutées pour exécuter 
l'exemple dans le Runtime zenon Runtime. Pour cela, ouvrez le menu contextuel dans 
l'explorateur du projet (Project Explorer) et cliquez sur Add Reference.. (Ajouter une 
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référence...).  
Les références requises dans cet exemple sont les suivantes : 

 Microsoft.VisualStudio.Tools.Applications.Runtime.v9.0 

 System 

 System.AddIn 

 System.Data 

 System.Windows.Forms 

 System.Xml 

 zenonVSTAProxy6500 

 

C# code 

using System; 

using System.Text.RegularExpressions; 

using System.IO; 

using System.Windows.Forms; 

 

namespace ProjectAddin 

{ 

[System.AddIn.AddIn("ThisProject", Version = "1.0", Publisher = "", Description =

 "")] 

public partial class ThisProject 

{ 

private void ThisProject_Startup(object sender, EventArgs e) 

{ 

} 

private void ThisProject_Shutdown(object sender, EventArgs e) 

{ 

} 

public void MacroGetFilteredVariables() 

{ 

string filename = string.Empty; 

string name = string.Empty; 

string description = string.Empty; 

string value = string.Empty; 

 

//définir le modèle d'expression régulière 

Regex match = new Regex("^([0-9]){3}[_]"); 

try 
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{ 

filename = FolderSelection("Sélectionnez l'emplacement auquel vous souhaitez 

conserver les informations sur les variables"); 

 

//créer le StreamWriter dans le fichier .txt 

StreamWriter matchedVariables = new StreamWriter(filename, true); 

//parcourir toutes les variables dans zenon 

for (int i = 0; i < this.Variables().Count; i++) 

{ 

//si le nom de la variable correspond au modèle, obtenir le nom, le nom de la balise 

et la valeur actuelle 

if (match.IsMatch(this.Variables().Item(i).Name)) 

{ 

name = this.Variables().Item(i).Name; 

description = this.Variables().Item(i).Tagname; 

value = this.Variables().Item(i).get_Value(0).ToString(); 

//écrire les informations dans le fichier .txt 

matchedVariables.WriteLine(name + ";" + description + ";" + value); 

} 

} 

//fermer le flux 

matchedVariables.Close(); 

} 

catch (Exception ex) 

{ 

 

MessageBox.Show("Une erreur s'est produite -> " + ex.Message); 

throw; 

} 

} 

private string FolderSelection(String caption) 

{ 

string selectedPath = string.Empty; 

//créer une boîte de dialogue de sélection du dossier de sortie 

FolderBrowserDialog folderSelect = new FolderBrowserDialog(); 

folderSelect.Description = caption; 

try 

{ 

if (folderSelect.ShowDialog() == DialogResult.OK) 
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{ 

//si la sélection était valide, obtenir la date actuelle et la convertir au format 

de date du fichier 

//ensuite, créer un fichier .txt avec le nom zenonVar et l'état correspondant 

DateTime currentTime = DateTime.Now; 

selectedPath = folderSelect.SelectedPath + "\\zenonVar" + currentTime.ToFileTime(

) + ".txt"; 

} 

} 

catch (Exception ex) 

{ 

MessageBox.Show("Une erreur est survenue : " + ex.Message); 

throw; 

} 

return selectedPath; 

} 

#region Code généré par VSTA 

private void InternalStartup() 

{ 

this.Startup += new System.EventHandler(ThisProject_Startup); 

this.Shutdown += new System.EventHandler(ThisProject_Shutdown); 

} 

#endregion 

} 

} 

 
 

6. PCE : Process Control Engine 

Attention 

À partir de la version 7.20, le module PCE n'est plus pris en charge et ne sera plus affiché 
dans l'arborescence des modules de zenon. Lors de la conversion de projets contenant 
des tâches PCE depuis des versions antérieures à la version 7.20, le nœud PCE sera affiché 
pour ces projets. PCE ne fera plus l'objet de développements ou de documentations 
ultérieures. 

  Veuillez utiliser zenon Logic, plutôt que PCE 
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6.1 L'éditeur PCE 

L'éditeur PCE est accessible dans le gestionnaire de projet, sous l'entrée Interfaces de programmation. 
Pour ouvrir l'éditeur PCE, sélectionner l'entrée Ouvrir l'éditeur PCE dans le menu contextuel. 

 
 

6.1.1 Le gestionnaire de tâches 

Le gestionnaire de tâches de l'éditeur PCE liste les tâches existantes et les variables liées. 

 

Un double-clic sur une tâche, l'ouvre dans la zone d'édition. Un menu contextuel est affiché en cliquant 
sur la tâche avec le bouton droit de la souris. 
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Le menu contextuel d'une tâche a les quatre entrées suivantes : 

Paramètre Description 

Propriétés de la tâche... Ouvre la boite de dialogue des propriétés de la tâche. 

Variables de la tâche... Ouvre la boite de sélection des variables. Vous pouvez ainsi ajouter de 
nouvelles variables à la tâche. 

Supprimer la tâche Supprime la tâche sans confirmation. 

Compiler une tâche Compile la tâche. 

 
 

6.1.2 La zone d'édition 

Dans la zone d'édition de l'éditeur PCE, le code des tâches est saisi en VB Script ou Java Script. 
 

6.1.3 La fenêtre de sortie 

 
 

6.1.4 Les menus de l'éditeur Moteur de contrôle de procédé (PCE) 

Menu Fichier 

Le menu Fichier contient les commandes suivantes : 

Paramètre Description 

Enregistrer Enregistre les nouvelles tâches et les 
tâches modifiées. 

Imprimer Imprime la tâche courante. 

Fermer Ferme l'éditeur PCE. 
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Menu Édition 

Le menu Editer contient les commandes suivantes : 

Paramètre Description 

Annuler Annule la dernière action. 

Répéter Refait la dernière action annulée. 

Couper "Déplace" le texte sélectionné dans le presse-papier 
Windows. 

Copier "Copie" le texte sélectionné dans le presse-papier Windows. 

Coller "Colle" le texte inclu dans le presse-papier Windows à la 
position du curseur. 

Supprimer  

Sélectionner tout Sélectionne le texte complet de la tâche. 

Rechercher Recherche un texte dans la tâche courante. 

Rechercher le suivant Recherche l'occurence suivante du texte recherché. 

Rechercher le précédent Recherche l'occurence précédente du texte recherché. 

Remplacer... Remplace un texte par un autre dans la tâche courante. 

Signets Gestion des signets dans le code de la tâche courante. 

- Spécifier un signet positionne un signet à la ligne sélectionnée dans le code. 

- Signet suivant va au signet suivant dans le code. 

- Signet précédent va au signet précédent dans le code. 

- Supprimer tous les signets supprime tous les signets dans le code. 

 
 

Menu Exécuter 

Le menu Exécuter contient les commandes suivantes : 

Enregistrer toutes les tâches et redémarrer  

Compiler une tâche Compile la tâche. 

 
 

Menu Options 

Le menu Options contient les commandes suivantes : 
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Paramètre Description 

Options Ouvre la boîte de paramétrage de l'éditeur Moteur de 
contrôle de procédé. 

Gestionnaire de 

tâches 
Ouvre / ferme le gestionnaire de tâches. 

Sortie Ouvre / ferme la fenêtre de suivi (sortie). 

Barre d'état Ouvre / ferme la barre d'état. 

 
 

Menu Fenêtre 

Le menu Fenêtre contient les commandes suivantes : 

Fermer 

Cascade 

Mosaïque 

Aligner les symboles 

Listes des dernières fenêtres 

ouvertes. 

 
 

Menu Aide 

Le menu Aide contient les commandes suivantes : 

Commande Action 

Aide Ouvre l’aide en ligne. 

A propos … Ouvre une fenêtre contenant des informations sur zenon : 

 Serial Number (Numéro de série) 

 Numéro d'activation 

 Identifiants/E/S couverts par la licence 

 Module couvert par la licence 

Un curseur permet de parcourir le contenu de la fenêtre d’informations. Cliquez sur 
la fenêtre ou appuyez sur la touche Échap pour fermer la fenêtre d’informations. 
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6.1.5 La barre de boutons de l'éditeur Moteur de contrôle de procédé (PCE) 

Les commandes principales de l'éditeur PCE peuvent aussi être exécutées depuis la barre de boutons. 

 

Les fonctions suivantes sont disponibles : 

Paramètre Description 

Fermer Ferme l'éditeur PCE. 

Enregistrer tout Enregistre les nouvelles tâches et les tâches modifiées. 

Imprimer le synoptique Imprime la tâche courante. 

Couper "Déplace" le texte sélectionné dans le presse-papier 
Windows. 

Copier "Copie" le texte sélectionné dans le presse-papier Windows. 

Coller "Colle" le texte inclu dans le presse-papier Windows à la 
position du curseur. 

Annuler Annule la dernière action. 

Répéter Refait la dernière action annulée. 

Rechercher Recherche un texte dans la tâche courante. 

Rechercher le suivant Recherche l'occurence suivante du texte recherché. 

Rechercher le précédent Recherche l'occurence précédente du texte recherché. 

Remplacer... Remplace un texte par un autre dans la tâche courante. 

Sauver et relancer  

Lancer debugger  

Signet suivant va au signet suivant dans le code. 

Spécifier un signet positionne un signet à la ligne sélectionnée dans le code. 

Signet précédent va au signet précédent dans le code. 

Supprimer tous les signets supprime tous les signets dans le code. 
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6.2 Suite des actions 

6.2.1 Créer une tâche 

Avec le menu contextuel du gestionnaire de tâche, une nouvelle tâche peut être créée. 

 
 

Propriétés de la tâche 

Après la création d'une tâche, la boîte de dialogue des propriétés de la nouvelle tâche s'ouvre 
automatiquement. 

 

Les propriétés suivantes peuvent être définies : 
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Paramètre Description 

Nom Nom unique de la tâche. 

Type Les tâches peuvent être exécutées de façon cyclique ou une seule fois. 

Cyclic (cyclique) : la tâche est exécutée cycliquement dans l'intervalle 
défini sous Temps de cycle à atteindre. 

Une fois : la tâche est exécutée une seule fois. 

Priorité Prioriétés du procédé pour les systèmes multithread ( idle, basse, normal, 
haute, la plus haute, critique (temps)).  
Par défaut : Normal  

Processus prioncipal : la tâche s'exécute dans le même thread que le 
Runtime. Si la tâche rentre dans une boucle d'attente ou si elle 'plante', cela 
influence aussi le Runtime. 

Fichier script Sélection du fichier script : Fichiers VB (*.vbs) pour les scripts VB ou Fichiers JS (*.js) 
pour les scripts Java.  
Le fichier correspondant est créé lorsque la tâche est ouverte dans la zone d'édition 
pour la première fois. 

Type de démarrage Démarrage du système : démarrage automatique, en même temps que le 
Runtime. (C'est la seule façon disponible si vous utilisez le PCE sous Windows CE, 
car Windows CE ne supporte pas le VBA). 

Événementiel : la tâche est démarrée dans une macro VBA avec la syntaxe 
suivante : thisProject.Tasks.Item("nom de la tâche").Run. 

Temps de cycle à 

atteindre 
Pour les tâches cyclique, c'est le temps qui doit être atteint par la tâche en 
millisecondes.  
Si ce temps de cycle n'est pas respecté, la tâche est exécutée aussi vite que 
possible. 

Pour des modifications ultérieures des propriétés, cette boîte de dialogue peut être ouverte par le menu 
contextuel de la tâche et l'entrée Propriétés tâche. 
 

Variables de la tâche 

Une fois les propriétés définies, la boîte de dialogue de sélection de variables s'ouvre automatiquement. 
Dans cette boîte de dialogue, vous pouvez sélectionner les variables devant être traitées dans la tâche. 

Toutes les variables lues ou écrites dans la tâche doivent être liées ici. Il est également possible 
d'accéder à une variable via l'objet de la variable, mais seules les valeurs directement liées à la tâche 
concernée sont automatiquement mises à jour lors de l'initialisation de la tâche, avant son exécution. 

La variable doit avoir le format : 

 

Task.Value('Nom de la variable')=123 

Si vous souhaitez modifier la sélection de la variable ultérieurement, il est également possible d'ouvrir 
cette boîte de dialogue en affichant le menu contextuel de la tâche et en sélectionnant l'entrée Tâche 

variables…. 
 



PCE : Process Control Engine 

 

 

112 

 

 

6.2.2 Entrer le code 

Double-cliquer sur une tâche dans le gestionnaire de tâche ouvre celle-ci dans la zone d'édition. Le 
fichier VBS ou JS correspondant est créé lorsque la tâche est ouverte pour la première fois. 

Quatre procédures sont créées automatiquement : 

Paramètre Description 

Task_Init() Cette procédure est exécutée automatiquement lorsque la tâche est 
démarrée. 

Task_Main() Cette procédure est exécutée soit une seule fois (type Une seule fois) ou 
cycliquement (type Cyclique). 

Task_Exit() Cette procédure est exécutée automatiquement lorsque la tâche est 
terminée. 

Task_Timer(lTimerId) Cette procédure est exécutée cycliquement tant que le Timer 
correspondant tourne. Le temps de cycle est défini en tant que paramètre 
lors du démarrage du Timer. 

De façon générale, le PCE utilise le même modèle d'objet que le VBA (voir les guides VBA). Lorsque vous 
utilisez des objets VBA (sauf l'objet Task) le 'multithreading' est perdu, car ces objets ne peuvent être 
utilisés que depuis le thread principal. 

 

Attention 

Dans l'interface COM, les fonctions ne bénéficient pas toutes de la possibilité de 
multi-thread et si ce n'est pas le cas, alors elles ne peuvent être utilisées que dans le 
contexte du thread principal. Si une propriété différente de "processus principal" est 
définie pour une tâche PCE, il ne doit alors pas y avoir d'accès depuis le PCE vers le thread 
principal. Dans le cas où il y a un quand même un accès à l'interface COM, ceci peut 
conduire à des états système indéterminés, comme par exemple, un blocage du Runtime. 

 

La collection Tasks et l'objet Task sont donc d'une importance spéciale. 
 

La collection Tasks 

Count 

Produi
t 

Parent 
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L'objet Task 

ActualCycleTime Propriété Temps de cycle courant de la tâche 

CountVariable Propriété Nombre de variables liées à la tâche 

CycleTime Propriété Temps de cycle défini pour la tâche 

DynProperties Propriété  

ErrorNumber Propriété  

ErrorString Propriété  

Quitter Événement  

A l'initialisation Événement  

ItemVariable Méthode  

Main Événement  

MemValue Propriété Avec "Task.MemValue("Nom")=valeur" une variable interne est 
créée et une valeur lui ait assignée. Il n'y a pas besoin de déclarer 
la variable au préallable. 

Cette variable peut aussi être utilisée depuis les autres tâches. 
Cela permet ainsi d'échanger des valeurs entre les tâches. 

Nom Propriété Nom de la tâche courante 

Parent Propriété La collection Tasks 

Priorité Propriété Priorité de la tâche courante 

Exécuter Méthode Démarre une tâche 

Sleep Méthode Suspend une tâche 

StartTimer Méthode La méthode "StartTimer" démarre un timer de la tâche. 

États Propriété  

Arrêter Méthode Arrête une tâche 

StopTimer Méthode La méthode "StopTimer" arrête un timer de la tâche. 

Timer Événement  

Type Propriété  

Valeur Propriété Avec "Task.Value("nom de la variable liée")=valeur" une variable 
du projet prend une nouvelle valeur. 

 
 

6.2.3 Fonction Visualiser PCE 

La fonction Visualiser PCE de zenon permet d'ouvrir l'Éditeur PCE depuis le Runtime. 
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6.2.4 Exécuter des tâches 

Tasks can be executed when the system is started or can be event-triggered. 

 
 

Exécution de tâches au démarrage du système 

Dans la configuration de la tâche, si e paramètre Type de démarrage est défini sur Démarrage du 
système , la tâche est automatiquement démarrée avec le Runtime. 

C'est la seule façon disponible si vous utilisez le PCE sous Windows CE, car Windows CE ne supporte pas 
le VBA. 
 

Exécuter des tâches déclenchées par un événement 

Sur un PC 

Une tâche peut aussi être démarrée selon un événement. Dans ce cas, le type de démarrage  doit être 
Selon événement. Maintenant la tâche n'est pas démarrée automatiquement avec le runtime. 

Une macro VBA doit être créée de façon à exécuter la tâche lorsqu'on sélectionne un bouton, ou lors 
d'un dépassement de limite ou sur n'importe quel autre événement. Avec l'instruction VBA suivante la 
tâche peut être démarrée : thisProject.Tasks.Item(Taskname).Run 
La tâche est démarrée automatiquement dans son propre 'thread' si la priopriété Processus principal 
n'a pas été activée. 

Avec l'instruction VBA suivante la tâche peut être arrêtée à tout moment : 
thisProject.Tasks.Item("Nom de la tâche").Stop 

  To execute a task more than once, it must also be explicitly stopped after it has ended, so 
that it can be restarted. 
Instruction: thisProject.Tasks.Item(Taskname).Stop 
It can be restarted after being stopped properly. 
 

Sur un terminal CE 

Comme Windows CE ne supporte pas VBA, la façon de faire décrite ci-avant n'est pas possible sur un 
terminal CE. Mais il y a, ici aussi, la possibilité d'exécuter des tâches déclenchées selon des événements. 

Une tâche avec le type de démarrage System start (Démarrage système) est créée. Cette tâche est 
démarrée automatiquement avec le runtime. Et cette tâche a la priorité PROCESSUS PRINCIPAL pour 
qu'elle tourne dans le même 'thread' que le runtime. Maintenant des variables 'bit' sont liées à cette 
tâche, et exécuteront d'autres tâches déclenchées selon un événement. Avec l'instruction suivante la 
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tâche peut être démarrée : Parent.Item(Taskname).Run 
La tâche est démarrée automatiquement dans son propre Thread si la priopriété Processus principal 
n'a pas été activée. 

Avec l'instruction suivante la tâche peut être arrêtée à tout moment : Parent.Item("Nom de la 
tâche").Stop 
 

6.3 VBScript - Introduction 

6.3.1 Type de données 

Variant 

VBScript possède un seul type de données, appelé Variant. Un Variant est un type de données spécial, 
qui peut contenir différentes sortes d'informations, en fonction de son utilisation. Parce que le type de 
données Variant est l'unique type de données disponible dans VBScript, il s'agit également du type de 
données renvoyé par toutes les fonctions dans VBScript. 

Dans sa forme la plus simple, un Variant peut contenir des informations numérique ou de chaîne. Un 
Variant se comporte comme un nombre lorsqu'il est utilisé dans un contexte numérique, et se comporte 
comme une chaîne lorsqu'il est utilisé dans une chaîne de texte. Concrètement, si vous utilisez des 
données qui ressemblent à des nombres, VBScript suppose qu'il s'agit de nombres et traite ces données 
de la manière la plus appropriée. Vous pouvez toujours utiliser des nombres comme des chaînes de 
caractères en les saisissant entre des guillemets (" "). Si vous utilisez des données pouvant uniquement 
être interprétées comme des chaînes, c'est ainsi que ces données seront interprétées par VBScript. 
 

Sous-type Variant 

En plus des classifications simples numérique ou chaîne, un Variant peut rajouter une distinction sur la 
nature spécifique d'une information numérique. Par exemple, vous pouvez avoir une information 
numérique qui représente une date ou une heure. Si on l'utilise avec une autre date ou heure, le 
résultat sera toujours exprimé comme une date ou une heure. Vous avez aussi une grande variété 
d'information numérique allant de valeurs booléennes jusqu'aux énormes nombres flottants (réels). Ces 
différentes catégories qui peuvent être contenues dans un élément Variant sont appelées sous-types. La 
plupart du temps, vous pouvez mettre le type de données que vous souhaitez dans un élément 
Variant  ; cet élément se comporte de la façon la plus appropriée par rapport aux données qu'il 
contient. 

Le récapitulatif suivant présente les sous-types de données que peut contenir un élément Variant. 
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Sous-type Signification 

Empty Le variant n'est pas initialisé. La valeur est 0 pour les variables numériques et une chaine 
de longueur nulle ("") pour les variables chaine. 

Null Le variant ne contient intentionnellement aucune donnée valide. 

Booléen Contient soit TRUE soit FALSE. 

Octet Contient un entier dans la plage de 0 à 255. 

Entier Contient un entier dans la plage de -32 768 à 32 767. 

Currency -922,337,203,685,477.5808 bis 922,337,203,685,477.5807. 

Long Contient un entier dans la plage de -2 147 483 648 à 2 147 483 647. 

Single Contient un nombre flottant (réel) simple précision dans la plage -3.402823E38 à 
-1.401298E-45 pour les valeurs négatives; 1.401298E-45 à 3.402823E38 pour les valeurs 
positives. 

Double Contient un nombre flottant (réel) double précision dans la plage 
-1.79769313486232E308 à -4.94065645841247E-324 pour les valeurs négatives; 
4.94065645841247E-324 à 1.79769313486232E308 pour les valeurs positives. 

Date (Time) Contient un nombre qui représente une date entre le 1er janvier 100 jusqu'au 31 
décembre 9999. 

Chaîne Contient une variable chaine qui peut contenir jusqu'à 2 milliards de caractères. 

Objet : Contient un objet. 

Erreur Contient un numéro d'erreur. 

 
 

6.3.2 Variables 

Une variable est un opérateur très utile, qui fait référence à un emplacement dans la mémoire de 
l'ordinateur dans lequel vous pouvez conserver des informations du programme susceptibles d'évoluer 
durant l'exécution de votre script. Par exemple, vous pouvez créer une variable appelée ClickCount pour 
mémoriser le nombre de fois qu'un utilisateur clique sur un objet sur une page Web particulière. 
L'emplacement auquel la variable est conservée dans la mémoire de l'ordinateur est sans importance. 
Ce qui est important, c'est que pour afficher ou modifier la valeur d'une variable, il suffit de la désigner 
par son nom. Dans VBScript, les variables appartiennent toujours à un type de données fondamental, 
Variant. 
 

Déclarer les variables 

Vous déclarez les variables de façon explicite en utilisant le mot clé Dim, ou Public ou encore Private. 
Exemple : 
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Dim DegresFahrenheit 

Vous déclarez plusieurs variables en les séparant avec une virgule. Exemple : 

Dim Haut, Bas, Gauche, Droit 
 

Restrictions concernant les noms 

Les noms de variable suivent les conventions de nommage du VBScript. Un nom de variable : 

 doit commencer par une lettre. 

 ne peut pas contenir un point. 

 ne doit pas excéder 255 caractères. 

 doit être unique dans la portée dans laquelle il est déclaré. 

 
 

Portée et durée de vie des variables 

Lorsque vous déclarez une variable dans une procédure, seul le code de la procédure peut lire ou 
modifier la valeur de cette variable. Elle a une portée locale et est une variable de niveau procédure. 

Si vous déclarez une variable en dehors d'une procédure, elle sera accessible par toutes les procédures 
du script. C'est une variable de niveau script et à une portée de niveau script. 

 

La durée de vie d'une variable correspond au temps pendant lequel elle existe. La vie d'une variable de 
niveau script démarre au moment où elle est déclarée jusqu'au moment où le script s'arrête. Une 
variable locale à une procédure n'existe que tant qu'on se trouve dans la procédure. Lorsqu'on sort de la 
procédure, la variable est supprimée. 

 

Les variables locales sont idéales pour stocker des données temporaires uniquement nécessaires dans la 
procédure. Vous pouvez avoir des variables locales de même nom dans différentes procédures car 
chacune d'elles n'est connue que dans la procédure dans laquelle elle est déclarée. 
 

Attribution de valeurs à des variables 

Pour attribuer des valeurs à des variables, on crée une expression comme suit : la variable est insérée à 
gauche de l'expression, tandis que la valeur que vous souhaitez attribuer à la variable se trouve à droite. 
Exemple : 

B = 200 
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Variables scalaires et variables de tableau 

Dans la plupart des cas, il n'est nécessaire d'attribuer qu'une seule valeur à une variable que vous avez 
déclarée. Une variable contenant une valeur unique est une variable scalaire. Dans certains cas, il est 
pratique de pouvoir assigner plus d'une valeur à une seule variable. Dans ce cas, vous créez une variable 
contenant une série de valeurs. Ce type de variable est appelé "variable de tableau". Les variables 
tableaux sont déclarées presque comme les variables scalaires. La seule différence est l'utilisation des 
parenthèses après leurs noms. Dans l'exemple suivant, une variable de tableau à une dimension 
contenant 11 éléments est déclarée : 

Dim A(10) 

Bien que le nombre indiqué entre parenthèses soit 10, tous les tableaux dans VBScript possèdent une 
base zéro, ce qui signifie que ce tableau comporte en réalité 11 éléments. Dans un système où le 
premier élément est à l'indice 0, le nombre d'élément d'un tableau est le nombre indiqué entre 
parenthèses + 1. Ce type de tableau est appelé "tableau à taille fixe". 

On utilise un index spécifique au tableau pour attribuer des données à chacun des éléments du tableau. 
En commençant à zéro et en finissant à 10, il est possible d'attribuer des données aux éléments d'un 
tableau comme indiqué ici : 

A(0) = 256 

A(1) = 324 

A(2) = 100 

. . . 

A(10) = 55 

De même, les données peuvent être extraites de chaque élément à l'aide d'un index spécifique à 
l'élément concerné du tableau de votre choix. Exemple : 

. . . 

SomeVariable = A(8) 

. . . 

Les tableaux ne sont pas limités à une dimension. Ils peuvent comporter jusqu'à 60 dimensions, bien 
que la plupart des utilisateurs ne puissent appréhender plus de trois ou quatre dimensions. Vous pouvez 
déclarer plusieurs dimensions en séparant les nombres définissant la taille d'un tableau (spécifiés entre 
parenthèses) par des virgules. Dans l'exemple suivant, la variable MyTable est un tableau à deux 
dimensions constitué de 6 lignes et 11 colonnes : 

Dim MyTable(5, 10) 

Dans un tableau à deux dimensions, le premier nombre représente toujours le nombre de lignes ; le 
deuxième nombre représente le nombre de colonnes. 

Vous pouvez également déclarer un tableau dont la taille évolue durant l'exécution de votre script. Ce 
type de tableau est appelé "tableau dynamique". Le tableau est initialement déclaré dans une 
procédure, à l'aide de la déclaration Dim ou ReDim. Toutefois, pour un tableau dynamique, aucune 
indication de taille ou de nombre de dimensions n'est insérée entre les parenthèses. Exemple : 

(Dim AnArray() 
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ReDim AnotherArray() 

Pour utiliser un tableau dynamique, vous devez ensuite utiliser la déclaration ReDim pour déterminer le 
nombre de dimensions et la taille de chaque dimension. Dans l'exemple suivant, ReDim définit la taille 
initiale du tableau dynamique sur 25. Une déclaration ReDim ultérieure redimensionne le tableau à 30, 
mais utilise le mot-clé Preserve pour préserver le contenu du tableau lors du redimensionnement. 

ReDim MyArray(25) 

. . . 

ReDim Preserve MyArray(30) 
 

6.3.3 Constantes 

Une constante est un nom significatif qui remplace un nombre ou une chaine de caractères et qui ne 
change jamais. Le VBScript définit un nombre de constantes intrinsèques. Vous pouvez obtenir des 
informations sur ces constantes intrinsèques à partir de la référence du langage VBScript. 

Vous pouvez créer des constantes utilisateur en VBScript en utilisant le mot clé Const. Vous pouvez ainsi 
donner un nom significatif pour les constantes textuelles ou numériques. Vous leur assignez leur valeur 
et ensuite, vous les utilisez dans un script. Exemple : 

Const MaChaine = "Ceci est une chaine de caractères." 

Const MonAge = 49 

Notez que les chaines de caractères sont encadrées par des guillemets (" "). Les guillemets sont le 
moyen le plus évident pour différentier les valeurs de chaines de caractères des valeurs numériques. La 
réprésentation des dates (type Date) et heures (type Time) sont encadrées par le signe dièse (#). 
Exemple : 

Const CutoffDate = #6-1-97# 

Vous pouvez définir une convention de nommage pour différentier les constantes des variables. Ceci 
vous permettra d'éviter d'assigner une valeur dans une constante dans vos scripts. Par exemple, vous 
pouvez utiliser les préfixes "vb" sur vos variables ou "cste" sur vos constantes ; vous pouvez aussi choisir 
d'écrire vos constantes en majuscules. Mais assurez-vous que les constantes et les variables peuvent 
bien être distinguées. Vous éviterez ainsi quelques problèmes lors de l'écriture de scripts complexes. 
 

6.3.4 Opérateurs 

VBScript comporte une vaste gamme d'opérateurs, et notamment des opérateurs arithmétiques, des 
opérateurs de comparaison, des opérateurs de concaténation et des opérateurs logique. 
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Priorité des opérateurs 

Si plusieurs opérateurs apparaissent dans un énoncé, chaque partie est évaluée selon un ordre 
prédéfini. Cet ordre est appelé la priorité des opérateurs. Vous pouvez utiliser des parenthèses pour 
changer l'ordre des priorités et forcer des parties d'une expression à être évaluées avant d'autres. Les 
opérations entre parenthèses sont toujours exécutées avant les opérations en dehors des parenthèses. 
Entre les parenthèses, cependant, la priorité des opérateurs est prise en compte. 

Lorsque des expressions contiennent des opérateurs de plus d'une catégorie, les opérateurs 
arithmétiques sont évalués en premier, puis les opérateurs de comparaison, et les opérateurs logiques 
sont évalués en dernier. Les opérateurs de comparaison sont d'égales priorités, et sont donc évalués de 
gauche à droite. Les opérateurs arithmétiques et logiques sont évalués dans l'ordre suivant. 
 

Opérateurs arithmétiques 

Description Symbole 

Mise en exposant ^ 

Négation unaire - 

Multiplication * 

Division / 

Division entière / 

Modulo Mod 

Addition + 

Soustraction - 

Concaténation de 
chaînes 
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Opérateurs de comparaison 

Description Symbole 

Egalité = 

Inégalité <> 

Inférieur à < 

Supérieur à > 

Inférieur ou égal à <= 

Supérieur ou égal à >= 

Equivalence d'objet Is 

 
 

Opérateurs logiques 

Si plusieurs opérateurs apparaissent dans un énoncé, chaque partie est évaluée selon un ordre 
prédéfini. Cet ordre est appelé la priorité des opérateurs. Vous pouvez utiliser des parenthèses pour 
changer l'ordre des priorités et forcer des parties d'une expression à être évaluées avant d'autres. Les 
opérations entre parenthèses sont toujours exécutées avant les opérations en dehors des parenthèses. 
Entre les parenthèses, cependant, la priorité des opérateurs est prise en compte. 

Lorsque des expressions contiennent des opérateurs de plus d'une catégorie, les opérateurs 
arithmétiques sont évalués en premier, puis les opérateurs de comparaison, et les opérateurs logiques 
sont évalués en dernier. Les opérateurs de comparaison sont d'égales priorités, et sont donc évalués de 
gauche à droite. Les opérateurs arithmétiques et logiques sont évalués dans l'ordre suivant. 
 

6.3.5 Déclarations conditionnelles 

Vous pouvez contrôler le déroulement de votre script au moyen de déclarations conditionnelles et de 
déclarations en boucle. À l'aide de déclarations conditionnelles, vous pouvez rédiger un code VBScript 
qui prend des décisions et répète des actions. 
 

Prise de décisions avec la déclaration If...Then...Else 

La déclaration If...Then...Else est utilisée pour évaluer si une condition est True (vraie) ou False 
(fausse) et, en fonction du résultat, pour spécifier une ou plusieurs déclarations à exécuter. 
Habituellement, la condition est une expression qui utilise un opérateur de comparaison pour comparer 
une valeur ou une variable avec une autre. Pour plus d'informations concernant les opérateurs de 
comparaison, reportez-vous à la section Opérateurs de comparaison. Les déclarations 
If...Then...Else peuvent être imbriquées à autant de niveaux différents que nécessaire. 
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Exécuter des traitements si une condition est vraie 

Pour n'exécuter qu'une seule instruction si une condition est vraie, utilisez la syntaxe sur une seule 
ligne pour le If...Then...Else. L'exemple suivant illustre la syntaxe avec une seule ligne. Notez que 
cet exemple n'utilise pas le mot clé Else. 

Sub FixDate()  

Dim myDate  

myDate = #2/13/95#  

If myDate < Now Then myDate = Now  

End Sub 

Pour exécuter plus qu'une ligne de code, vous devez utiliser la syntaxe correspondante. Cette syntaxe 
inclue l'instruction End If, comme montré dans l'exemple suivant : 

Sub AlertUser(value)  

If value = 0 Then  

AlertLabel.ForeColor = vbRed  

AlertLabel.Font.Bold = True  

AlertLabel.Font.Italic = True  

End If  

End Sub 

Pour n'exécuter qu'une seule instruction si une condition est vraie, utilisez la syntaxe sur une seule 
ligne pour le If...Then...Else. L'exemple suivant illustre la syntaxe avec une seule ligne. Notez que 
cet exemple n'utilise pas le mot clé Else. 

Sub FixDate()  

Dim myDate  

myDate = #2/13/95#  

If myDate < Now Then myDate = Now  

End Sub 

Pour exécuter plus qu'une ligne de code, vous devez utiliser la syntaxe correspondante. Cette syntaxe 
inclue l'instruction End If, comme montré dans l'exemple suivant : 

Sub AlertUser(value)  

If value = 0 Then  

AlertLabel.ForeColor = vbRed  

AlertLabel.Font.Bold = True  

AlertLabel.Font.Italic = True  

End If  

End Sub 
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Exécute certains traitements si une condition est vraie et d'autres traitements si la condition 
est fausse. 

Vous pouvez utiliser une déclaration If...Then...Else pour définir deux blocs de déclarations 
exécutables : un bloc à exécuter si la condition est True, et un autre bloc à exécuter si la condition est 
False. 

Sub AlertUser(value)  

If value = 0 Then  

AlertLabel.ForeColor = vbRed  

AlertLabel.Font.Bold = True  

AlertLabel.Font.Italic = True  

Else  

AlertLabel.Forecolor = vbBlack  

AlertLabel.Font.Bold = False  

AlertLabel.Font.Italic = False  

End If  

End Sub 
 

Décider entre plusieurs alternatives 

Une variante du If...Then...Else permet de choisir entre plusieurs alternatives. En ajoutant le mot 
clé ElseIf on étend les possibilités du If...Then...Else pour orienter le flux du programme selon 
diverses conditions. 

Exemple : 

Sub ReportValue(value)  

If value = 0 Then  

MsgBox value  

ElseIf value = 1 Then  

MsgBox value  

ElseIf value = 2 then  

Msgbox value  

Else   

Msgbox Walue out of range!  

End If 
 

Prise de décisions avec la déclaration Select Case 

La structure Select Case fournit une alternative au If...Then...ElseIf pour exécuter un bloc 
d'instructions ou un autre parmi plusieurs blocs d'instructions. Une déclaration Select Case fournit 
une capacité semblable à la déclaration If...Then...Else, mais elle rend le code plus efficace et 
lisible. 

Un Select Case marche avec une expression simple qui n'est évaluée qu'une fois au début de la 
structure. Le résultat de l'expression est alors comparé avec les valeurs de chaque Case à l'intérieur de 
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la structure. En cas de correspondance, le bloc de déclarations associé à la déclaration Case est exécuté, 
comme dans l'exemple suivant. 

Select Case Document.Form1.CardType.Options(SelectedIndex).Text  

Case MasterCard  

DisplayMCLogo  

ValidateMCAccount  

Case Visa  

DisplayVisaLogo  

ValidateVisaAccount  

Case American Express  

DisplayAMEXCOLogo  

ValidateAMEXCOAccount  

Case Else  

DisplayUnknownImage  

PromptAgain  

End Select 
 

6.3.6 Utilisation de boucles de code 

L'utilisation de boucles vous permet d'exécuter un groupe de déclarations à plusieurs reprises. Certaines 
boucles répètent des déclarations jusqu'à ce qu'une condition soit False (fausse) ; d'autres répètent 
des déclarations jusqu'à ce qu'une condition soit True (vraie). Il existe également des boucles qui 
répètent des déclarations un nombre spécifique de fois. 

Les déclarations en boucle suivantes sont disponibles dans VBScript : 

Paramètre Description 

Utilisation de boucles Do (à la 
page 125) : 

exécute une boucle pendant ou jusqu'à ce qu'une condition soit True (vraie). 

Utilisation de boucles 
While...Wend (à la page 127) : 

exécute une boucle pendant qu'une condition est True (vraie). 

Utilisation de boucles For...Next 
(à la page 127) : 

utilise un compteur pour exécuter des déclarations un certain nombre de fois. 

Utilisation de boucles For 
Each...Next (à la page 128) : 

répète un groupe de déclarations pour chaque article d'une collection ou chaque élément d'un tableau. 
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Utilisation des déclarations Do... Loop 

Vous pouvez utiliser des déclarations Do...Loop  pour exécuter un bloc de déclarations autant de fois 
que vous le souhaitez. Les déclarations sont répétées lorsqu'une condition est True (vraie) ou jusqu'à ce 
qu'une condition devienne True (vraie). 
 

Répéter des déclarations lorsqu'une condition est True (vraie) 

Utilisez le mot-clé While pour vérifier une condition dans une déclaration Do...Loop. Vous pouvez 
contrôler la condition avant de définir la boucle (comme indiqué dans l'exemple ChkFirstWhile 
ci-dessous), ou vous pouvez la contrôler après une exécution au moins de la boucle (comme indiqué 
dans l'exemple ChkLastWhile). Dans la procédure ChkFirstWhile, si monNum est défini sur 9 au lieu de 
20, les déclarations à l'intérieur de la boucle ne s'exécuteront jamais. Dans la procédure ChkLastWhile, 
les déclarations à l'intérieur de la boucle s'exécutent une fois seulement, car la condition est déjà False 
(fausse). 

Sub ChkFirstWhile()  

 Dim counter, myNum  

 counter = 0 

monNum = 20 

Do While monNum > 10 

monNum = monNum - 1 

compteur = compteur + 1 

Loop 

MsgBox 'La boucle a fait ' & compteur & ' répétitions.' 

End Sub 

 

Sub ChkLastWhile() 

Dim compteur, monNum 

compteur = 0 

monNum = 9 

Do   

 myNum = myNum - 1  

 counter = counter + 1 

Loop While monNum > 10 

MsgBox 'La boucle a fait ' & compteur & ' répétitions.' 

End Sub 
 

Répéter une déclaration jusqu'à ce qu'une condition devienne True (vraie) 
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Il existe deux manières d'utiliser le mot-clé Until pour vérifier une condition dans une déclaration 
Do...Loop. Vous pouvez contrôler la condition avant de définir la boucle (comme indiqué dans 
l'exemple ChkFirstUntil ci-dessous), ou vous pouvez la contrôler après une exécution au moins de la 
boucle (comme indiqué dans l'exemple ChkLastUntil). Tant que la condition est False, la boucle 
s'exécute. 

Sub ChkFirstUntil() 

Dim compteur, monNum 

compteur = 0 

monNum = 20 

Do Until monNum = 10 

monNum = monNum - 1 

compteur = compteur + 1 

Loop 

MsgBox 'La boucle a fait ' & compteur & ' répétitions.' 

End Sub 

 

Sub ChkLastUntil() 

Dim compteur, monNum 

compteur = 0 

monNum = 1 

Je 

monNum = monNum - 1 

compteur = compteur + 1 

Loop Until monNum = 10 

MsgBox 'La boucle a fait ' & compteur & ' répétitions.' 

End Sub 
 

Sortir d'une boucle Do ... Loop depuis l'intérieur de la boucle 

 

Vous pouvez sortir d'un Do...Loop en utilisant l'instruction Exit Do. Parce qu'il est souvent nécessaire 
de sortir d'une boucle seulement dans certaines situations, pour éviter des boucles infinies, il est 
préférable d'utiliser l'instruction Exit Do dans la partie vraie d'un énoncé  If...Then...Else. Si 
la condition est fausse, la boucle continue à fonctionner normalement. 

Dans l'exemple suivant, monNum est assigné à une valeur qui crée une boucle infinie. L'énoncé 
If...Then...Else vérifie cette condition de façon à éviter cette boucle infinie. 

Sub ExitExemple() 

Dim compteur, monNum 

compteur = 0 
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monNum = 9 

Do Until monNum = 10 

monNum = monNum - 1 

compteur = compteur + 1 

If monNum < 10 Then Exit Do 

Loop 

MsgBox 'La boucle a fait ' & compteur & ' répétitions.' 

End Sub 
 

Utilisation de boucles While...Wend 

La déclaration While...Wend est incluse dans VBScript à l'intention des développeurs familiarisés avec 
son utilisation. Toutefois, en raison du manque de flexibilité inhérent aux déclarations While...Wend, 
nous vous recommandons d'utiliser les déclarations Do...Loop à leur place. 
 

Utilisation des déclarations For...Next 

Vous pouvez utiliser des déclarations For...Next pour exécuter un bloc de déclarations un nombre 
spécifique de fois. Pour les boucles, utilisez un compteur de variables dont la valeur augmente ou 
diminue à chaque répétition de la boucle. 

L'exemple suivant déclenche 50 exécutions d'une procédure appelée MyProc. La déclaration For 
spécifie le compteur de variables x et ses valeurs de début et de fin. La déclaration Next augmente la 
variable du compteur de 1. 

Sub DoMyProc50Times() 

Dim x 

For x = 1 To 50 

MyProc 

Suivant 

 End Sub 

À l'aide du mot-clé Step, vous pouvez augmenter ou diminuer la variable du compteur selon la valeur 
spécifiée. Dans l'exemple suivant, la variable du compteur j est augmentée de 2 à chaque réinitialisation 
de la boucle. Lorsque la boucle est terminée, le total est la somme de 2, 4, 6, 8 et 10. 

Sub DoMyProc50Times() 

Dim x 

For x = 1 To 50 

MyProc 

Suivant 

 End Sub 
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Pour diminuer la variable du compteur, utilisez une valeur Step négative. Vous devez spécifier une 
valeur de fin inférieure à la valeur de début. Dans l'exemple suivant, la variable du compteur monNum 
est diminuée de 2 à chaque réinitialisation de la boucle. Lorsque la boucle est terminée, le total est la 
somme de 16, 14, 12, 10, 8, 6, 4 et 2. 

Sub NewTotal() 

Dim monNum, total 

For monNum = 16 To 2 Step -2 

total = total + monNum 

Suivant 

MsgBox 'Le total est de ' & total 

End Sub 
 

Utilisation de boucles For Each...Next 

Une boucle For Each...Next est semblable à une boucle For...Next. Au lieu de répéter les 
déclarations un nombre de fois, une boucle For Each...Next répète un groupe de déclarations pour 
chaque élément d'une collection d'objets ou pour chaque élément d'un tableau. Cette déclaration 
s'avère particulièrement utile si vous ne savez pas combien d'éléments comporte une collection. 

Dans l'exemple de code HTML suivant, le contenu d'un objet Dictionary est utilisé pour insérer du 
texte dans plusieurs zones de texte. 

 <HTML> 

 <HEAD><TITLE>Formulare und Elemente</TITLE></HEAD> 

 <SCRIPT LANGUAGE='VBScript'> 

 <!-- 

 Sub cmdChange_OnClick 

 Dim d 'Create a variable 

 Set d = CreateObject('Scripting.Dictionary') 

 d.Add '0', 'Athen' 'Add some keys and items 

 d.Add '1', 'Belgrade' 

 d.Add '2', 'Le Caire' 

  

 For Each I in d 

 Document.frmForm.Elements(I).Value = D.Item(I) 

 Suivant 

 End Sub 

 --> 

 </SCRIPT> 

 <BODY> 
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 <CENTER> 

 <FORM NAME='frmForm' 

  

 <Input Type = 'Text'><p> 

 <Input Type = 'Text'><p> 

 <Input Type = 'Text'><p> 

 <Input Type = 'Text'><p> 

 <Input Type = 'Button' NAME='cmdChange' VALUE='Hierauf klicken'><p> 

 </FORM> 

 </CENTER> 

 </BODY> 

 </HTML> 
 

6.3.7 Types de procédures 

Procédures Sub 

Une procédure Sub est une série de déclarations VBScript (délimitée par des déclarations Sub et End 
Sub) qui exécutent des actions, mais ne renvoient aucune valeur. Une procédure Sub peut avoir des 
arguments (constantes, variables ou expressions qui lui sont passées par la procédure appelante). Si une 
procédure Sub n'a pas d'argument, sa déclaration Sub doit inclure une parenthèse ouvrante et une 
parenthèse fermante (). 

La procédure Sub suivante utilise deux fonctions VBScript intrinsèques (ou intégrées), MsgBox ert 
InputBox, pour inviter l'utilisateur à saisir des informations. Elle affiche ensuite les résultats d'un calcul 
basé sur ces informations. Le calcul est exécuté dans la procédure Function créée à l'aide de VBScript. 
La procédure Function est sera présentée après l'exposé suivant. 

Sub ConvertTemp() 

temp = InputBox('Veuillez entrer la température en degrés F.', 1) 

MsgBox 'La température est de ' & Celsius(temp) & ' degrés C.' 

End Sub 
 

Les procédures 'Function' 

 

Une procédure Function est une série d'instructions VBScript inclue entre les mots clé Function et 
End Function. Une procédure Function est similaire à une procédure Sub mais en plus elle retourne 
une valeur. Une procédure Function peut avoir des arguments (constantes, variables ou expressions 
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qui lui sont passées par la procédure appelante). Si une procédure Function n'a pas d'argument, sa 
déclaration Function doit inclure une parenthèse ouvrante et une parenthèse fermante. Une 
Function retourne une valeur en affectant une valeur directement dans le nom de la fonction dans 
une instruction de la procédure. Le type de la valeur retournée par une Function est toujours un 
Variant. 

Dans l'exemple suivant, la fonction Celsius fait la conversion en degrés Celsius d'une valeur en degrés 
Fahrenheit. Quand la fonction est appelée à partir de la procédure Sub ConvertirTemp, une variable 
contenant la valeur de l'argument est passé à la fonction. Le résultat du calcul est retourné à la 
procédure appelante et affiché dans un message (message box). 

Sub ConvertTemp() 

temp = InputBox('Veuillez entrer la température en degrés F.', 1) 

MsgBox 'La température est de ' & Celsius(temp) & ' degrés C.' 

End Sub 

 

Function Celsius(fDegres) 

Celsius = (fDegres - 32) * 5 / 9 

End Function 
 

Insertion ou extraction de données dans les procédures 

 

Chaque fragment de données est transmis à vos procédures à l'aide d'un argument . Les arguments 
servent d'opérateurs pour les données que vous souhaitez intégrer à votre procédure. Lorsque vous 
créez une procédure à l'aide de la déclaration Sub ou de la déclaration Function, vous devez inclure 
des parenthèses après le nom de la procédure. Les éventuels arguments doivent être insérés entre ces 
parenthèses, séparés par des virgules. Par exemple, dans l'exemple suivant, fDegrees est un opérateur 
représentant la valeur transmise à la fonction Celsius aux fins de la conversion. 

Function Celsius(fDegres) 

Celsius = (fDegres - 32) * 5 / 9 

End Function 
 

Utilisation des procédures Sub et Function dans le code 

 

Dans du code, une procédure Function doit toujours être insérée à droite d'une attribution de variable 
ou dans une expression. 

Exemples : 

 Temp = Celsius(fDegrees) 

ou 
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 MsgBox 'La température est de ' & Celsius(temp) & ' degrés C.' 

Pour appeler une procédure Sub depuis une autre procédure, saisissez le nom de la procédure avec des 
valeurs pour les éventuels arguments nécessaires, en séparant chaque valeur par une virgule. La 
déclaration Call n'est pas requise, mais si vous l'utilisez, vous devez insérer les éventuels arguments 
entre parenthèses. 

L'exemple suivant présente deux appels de procédure MyProc. Dans un cas, la déclaration Call est 
insérée dans le code, mais pas dans l'autre. Les deux appels renvoient le même résultat. 

Call MyProc(premierarg, secondarg) 

MyProc premierarg, secondarg 
 

6.3.8 Conventions de codage 

Les conventions de codage sont des suggestions destinées à vous aider dans l'écriture de vos scripts 
utilisant Microsoft Visual Basic Scripting Edition. 

 

Les conventions de codage peuvent inclure les points suivants : 

Conventions de nommage des objets, variables, et procédures 

Conventions pour les commentaires 

Formatage du texte et règles d'indentation 

La raison principale pour l'utilisation d'un jeu de conventions cohérent est de standardiser la structure 
et le style du codage pour un script ou un groupe de scripts de façon à ce que vous et d'autres 
personnes puissent lire et comprendre le code facilement. Utiliser de bonnes conventions de codage 
permet d'avoir un code source clair, précis et lisible, qui est cohérent avec les conventions d'autres 
langages et intuitif. 
 

Conventions de nommage constantes 

Les versions antérieures de VBScript ne comportaient aucun mécanisme autorisant la création de 
constantes définies par l'utilisateur. Les constantes, le cas échéant, étaient mises en œuvre sous forme 
de variables et se distinguaient des autres variables par l'utilisation de caractères en majuscules. 
Plusieurs mots étaient séparés à l'aide du caractère "tiret bas" (_). 

Exemples : 

 

USER_LIST_MAX  

NEW_LINE 

Bien que cette manière de nommer les constantes fonctionne toujours, vous pouvez utiliser une autre 
méthode de dénomination. Vous pouvez créer des constantes réelles à l'aide de l'instruction Const. 
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Cette convention utilise un format à casse mixte, dans lequel les noms de constantes comportent le 
préfixe "con". 

Par exemple : 

 

conYourOwnConstant 
 

Conventions de nommage des variables 

Pour améliorer la lisibilité et la cohérence de vos scripts, utilisez le récapitulatif suivant et des noms 
descriptifs pour les variables de votre code VBScript. 

Sous-type Préfixe Exemple 

Booléen bln blnTrouve 

Octet byt bytDonneeBrute 

Date (Time) dtm dtmDebut 

Double dbl dblTolerance 

Erreur err errNumOrdre 

Entier int intQuantite 

Long lng lngDistance 

Objet : obj objCourant 

Single sng sngMoyenne 

Chaîne str strPrenom 

 
 

Portée des variables 

Les variables doivent toujours être définies avec la plus petite portée possible. Les variables des scripts 
VB peuvent avoir les portées suivantes. 

Plage valide Déclaration Visibilité 

Niveau procédure Event, Function ou Sub. Visible dans la procédure dans laquelle 
elle est déclarée. 

Niveau script Section HEAD d'une page HTML, en 
dehors de toute procédure. 

Visible dans chaque procédure du 
script. 
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Préfixes des portées des variables 

Lorsque vos scripts grossissent, il peut devenir difficile de différentier rapidement la portée des variables 
utilisées. Une lettre préfixe, identifiant la portée et précédant le préfixe concernant le type, peut être 
utilisée, sans augmenter trop la longueur des noms de variables. 

Plage valide Préfixe Exemple 

Niveau procédure Aucun dblVitesse 

Niveau script s sblnCalcEnCours 

 
 

Noms de variables et de procédures 

Dans les noms de variable ou de procédure, les majuscules peuvent être utilisées. Le nom doit être assez 
long pour décrire l'utilisation de la variable. En plus, les noms de procédure devraient commencer par 
un verbe, comme par exemple InitTableau ou FermerDialogue. 

Pour les termes fréquemment utilisés ou les termes longs, des abréviations standard sont 
recommandées pour garder une longueur de nom raisonnable. En général, les noms de variable 
supérieurs à 32 caractères sont difficiles à lire. Si vous utilisez des abréviations, faites en sorte d'utilser 
toujours les mêmes et de façon cohérente dans tout le script. Par exemple, utiliser tantôt Cnt ou tantôt 
Count dans un même script peut engendrer une certaine confusion. 
 

Conventions de nommage des objets 

La table suivante liste les conventions recommandées pour les objets lors de la programmation en 
VBScript. 
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Type d'objet Préfixe Exemple 

Panel 3D pnl pnlGroup 

Bouton animé ani aniboîteMail 

Check box chk chkLectureSeule 

Combo box, liste déroulante cbo cboAnglais 

Bouton commande cmd cmdQuitter 

Dialogue dlg dlgOuvertureFichier 

Gabarit fra fraLangue 

Barre de défilement horizontale (scrollbar) hsb hsbVolume 

Image img imgIcone 

Label lbl lblMessageAide 

Ligne lin linVerticale 

Liste lst lstCodes 

Spin spn spnPages 

Texte txt txtNom 

Barre de défilement verticale (scrollbar) vsb vsbTaux 

Réglette sld sldEchelle 

 
 

Conventions pour commenter le code 

Chaque procédure devrait commencer par un bref commentaire décrivant le but de la procédure. Cette 
description ne doit pas entrer dans les détails de l'implémentation (comment les opérations sont 
exécutées), car ceux-ci peuvent éventuellement évoluer avec le temps. Ceci pourrait engendrer des 
efforts de maintenance sur les commentaires et - pire encore - conduire à des commentaires faux. Le 
code lui-même et des commentaires entre les lignes de code décrivent l'implémentation. 

Les arguments passés à une procédure doivent être décrits lorsque leur rôle n'est pas évident et lorsque 
la procédure s'attend à ce qu'ils soient dans une plage de valeurs spécifique. Les valeurs retournées par 
les fonctions et les variables qui sont modifiées par une procédure, particulièrement avec des 
arguments passés par référence, doivent aussi être décrites au début de la procédure. 

Les commentaires en entête de procédure doivent inclure les sections suivantes. Par exemple, voir la 
section "Formater votre code" qui suit. 
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Section entête Commentaire 

But Ce que fait la procédure (et non pas comment elle le fait). 

Hypothèses Liste des effets de la procédure sur chaque variable externe, contrôle ou 
autre élément. 

Effets Liste des effets de la procédure sur chaque variable externe, contrôle ou 
autre élément. 

Entrées Explication de chaque argument qui n'est pas évident. Chaque argument 
doit apparaître sur une ligne différente. 

Valeurs retournées Explication de la valeur retournée. 

Points à se rappeler : 

Chaque variable importante doit contenir un commentaire sur son utilisation dans sa ligne de déclaration. 

Les variables, contrôles et procédures doivent être nommés clairement de façon à fournir une 
auto-documentation ; ainsi seuls les éléments complexes nécessitent un commentaire détaillé. 

Au début du script, vous devriez inclure un descriptif global, énumérant les objets, procédures, algorithmes, 
boîtes de dialogue et dépendances système. Parfois quelques lignes de pseudocode peut aider à comprendre 
un algorithme. 

 
 

Mise en forme du code 

L'espace écran doit être économisé autant que possible, mais tout en permettant que le formatage du 
code reflète la structure logique et l'imbrication. Voici quelques suggestions : 

 Indenter les blocs imbriqués de 4 espaces. 

 Indenter les commentaires généraux des procédures de 1 espace. 

 Les instructions du niveau le plus haut, suivant directement le commentaire général, doivent 
être indentées de 4 espaces. Chaque bloc imbriqué suivant doit, à son tour, être identé de 4 
espaces. 

Exemple : 

Le code suivant respecte les conventions de codage du VB script. 

 ' But : Recherche la 1ière occurence de l'utilisateur donné dans UserList. 

 Entrées : strUserList(): liste d'utilisateurs dans laquelle il faut chercher. 

 strZielUser: nom de l'utilisateur recherché. 

 Valeurs retournées : Index de la première occurence de strTargetUser dans strUserList.  
Si l'utilisateur recherché n'est pas trouvé, retourne -1. -1. 

Function intFindUser (strUserList(), strTargetUser) 

Dim i ' Loop counter. 
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Dim blnFound ' 'Target found' flag. 

intFindUser = -1 

i = 0 ' Initialize loop counter 

Do While i <= Ubound(strUserList) and Not blnFound 

If strUserList(i) = strTargetUser Then 

blnFound = True ' Set flag to True 

intFindUser = i ' Set return value to loop count 

End If 

i = i + 1 ' Increment loop counter 

Loop 

 End Function 
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